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ÖZET  

 

SÜLEYMANİYE CAMİİ’NİN YEREL ZEMİN KOŞULARINA BAĞLI DEPREM 
PERFORMANSININ DEĞERLENDİRİLMESİ 

 

Ayhan ASLAN 

 

İnşaat Mühendisliği Yapı Anabilim Dalı 

Yüksek Lisans Tezi 

 

Tez Danışmanı: Doç. Dr. Abdurrahman ŞAHİN 

 

Mimar Sinan’ın 1550 yılında yapımına başladığı ve 7 senede yapımını bitirdiği Süleymaniye 
Camii, bu çalışmada 3 boyutlu olarak modellenmiş, bölgedeki sondaj verileri ile yapının 
üzerinde bulunduğu zemin modellenmiş ve farklı karakterdeki depremler ile zemine bağlı 
elde edilen deprem kayıtlarının etkisi altında yapının davranışı incelenmiştir. Yapısal 
modellemede katı ve kabuk elemanlar kullanılmış, sonlu elemanlar yöntemi ile analiz 
yapılmıştır. Oluşturulan model geçmiş çalışmalarda yapılan titreşim deney sonuçları referans 
alınarak güncellenmiştir. Bunun yanında, dünyanın farklı bölgelerinde yaşanmış deprem 
kayıtları değerlendirme amaçlı olarak yapıya doğrudan etki ettirilmiştir. Analizler sonucunda 
yapının deprem etkileri altında yapacağı davranışlar elde edilmiştir. Yapının depremlerden 
en çok etkilenen bölgeleri tespit edilmiş ve yapıda meydana gelen yer değiştirme ve 
gerilmelere bağlı olarak davranış irdelenmiştir. Sonuçlar neticesinde değerlendirmeler 
yapılmıştır. 

Anahtar Kelimeler: Süleymaniye Camii, Deprem Analizi, Yığma Yapı, Tarihi Yapı, Sonlu 
Elemanlar Yöntemi, Dinamik Analiz, Zaman Tanım Alanında Analiz, Sap2000 
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ABSTRACT 

 

EARTHQUAKE PERFORMANCE EVALUATION OF SULEYMANIYE MOSQUE 
DEPENDING ON LOCAL SOIL CONDITIONS 

 

Ayhan ASLAN 

 

Department of Civil Engineering 

MSc. Thesis 

 

Adviser: Assoc. Prof. Dr. Abdurrahman ŞAHİN 

 

In this study, 3D structural model of Suleymaniye Mosque which Mimar Sinan began the 
construction in 1550 and finished in 7 years is developed, the soil where the structure is 
located is modeled by using the borehole data and the behavior of the structure is 
examined under the influence of earthquakes with different characters and seismic 
records produced depending on the soil model. Solid and shell elements are used for 
structural modeling and analyses are performed with finite element method. The 
developed model is updated by comparing with the previous vibration test results. In 
addition, earthquake records in different parts of the world are directly applied to the 
structure for the purpose of evaluation. At the end of the analyses, the behavior of the 
structure under the earthquake effects is obtained. The most affected areas of the 
structure are determined and the structural behavior is investigated depending on the 
displacement and stresses over the structure. Finally, assessments have been made 
about the obtained results. 

Keywords: Suleymaniye Mosque, Earthquake Analysis, Masonry Structure, Historical 
Structure, Finite Element Method, Dynamic Analysis, Time History Analysis, Sap2000 
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BÖLÜM 1 

GİRİŞ 

Bu tez çalışmasında Süleymaniye Camii, tam ölçekli olarak modellenmiş, yerel zemin 

koşulları dikkate alınarak zemin modeli oluşturulmuş ve deprem etkisi altında yapısal 

davranışı incelenerek değerlendirmeler yapılmıştır. 

Ülkemiz tarihi yapı mirası bakımından oldukça zengin bir birikime sahiptir. Pek çok tarihi 

yapı ise halen aktif olarak kullanılmaktadır. Özellikle Osmanlı döneminden kalma camiler 

İstanbul’da yoğun olarak kullanılmakta, turistik olarak pek çok ziyaretçiye ev sahipliği 

yapmaktadır. Bu camiler içerisinde en meşhurlarından olan Süleymaniye Camii, 16. 

yüzyılda Mimar Sinan tarafından dönemin padişahı olan Kanuni Sultan Süleyman adına 

İstanbul’da inşa edilmiştir. Mimar Sinan’ın kalfalık dönemi yapılarından olan cami Klasik 

Osmanlı Mimarisinin en önemli örneklerinden birisidir. 

  Literatür Özeti 

Selahiye vd. [1] tarafından 1995 yılında yapılan çalışmada, Süleymaniye Camii'nin 

çevresel titreşim deneyleri ve üç boyutlu sonlu elemanlar analizi yapılarak yapının doğal 

titreşim frekansları ve mod şekilleri elde edilmiştir. Camiye yerleştirilen dokuz adet 

hassas yer hareketi kaydedicisi ile 1994 yılında kaydedilen küçük şiddetli bir depremin 

kayıtlarından yararlanılarak aynı dinamik özellikler tekrar bulunmuştur. Üç şekilde de 

elde edilen doğal titreşim frekansları birbirlerine yakın sonuçlar vermiş ve sonuçların 

güvenirliliğini kanıtlamıştır. 

Giordano vd. [2] tarafından 2002 yılında yapılan çalışmada, yığma yapıların analizi 

amacıyla farklı numerik modelleme teknikleri incelenmiştir. Deneysel test verileri tam 

ölçekli örnek yığma yapıdan elde edilmiştir. Üç farklı modelleme yaklaşımı üzerinde 
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durulmuştur. ABAQUS, CASTEM 2000 ve UDEC programları ile Sao Vicente de Fora 

manastırının örnek alınan yeri incelenmiştir. Program analiz sonuçları tek tek incelenmiş, 

deneysel veriler ve programların sonuçları birbirleri ile karşılaştırılmıştır. 

Teomete [3] tarafından 2004 yılında yapılan çalışmada, tarihi yığma yapıların sonlu 

elemanlar metodu ile modellenmesi incelenmiştir. Urla Kamanlı Cami’nin sonlu 

elemanlar modeli oluşturulup, analizi LUSAS adlı uygulama ile gerçekleştirilmiştir. 

Tarihçe araştırılması, rölöve, uzun dönem gözlemler, malzeme testleri yapılmıştır. 

Bölgedeki depremler ve yerel zemin koşulları incelenmiştir. Yapının kendi ağırlığı altında 

güvenli olduğu tespit edilmiştir. Kasnak kubbe birleşimi ile kasnak ve 2. seviye 

pencerelerde önemli miktarlarda gerilmeler tespit edilmiştir. Sismik analiz, tepki 

spektrumu kullanılarak yapılmıştır. Hatıl boşlukları ve kasnak kubbe birleşimlerinin 

sismik yük altında tehlikede olduğu tespit edilmiştir. Yapıdaki mevcut çatlakların oturma 

ve yapının ölü yükü nedeni ile olduğu tespit edilmiştir. Doğrusal olmayan oturma ve ölü 

yük analizi LUSAS programında ve beton malzeme modeli kullanılarak 

gerçekleştirilmiştir. Yapıda mevcut olan çatlakların 1. asal gerilme konturları ile 

uyuşmakta olduğu belirlenmiştir. LUSAS programının beton malzeme modelinin yığma 

yapıları modellemek için uygun olduğu kanaatine varılmıştır. 

Bayraktar [4] tarafından 2005 yılında yapılan çalışmada, tarihi yığma yapıların sismik 

güçlendirmesi çalışmalarında uyulması gereken hesap ve yapım kuralları hakkında bilgi 

verilmiştir. SGM 365 metodu ve alternatif önerilerden bahsedilmiştir. 

Sallıo [5] tarafından 2005 yılında yapılan çalışmada, 1950’li yıllarda yığma yapı olarak 

inşa edilen Buldan Göğüs Hastalıkları Hastanesi’nin bazı duvarların püskürtme beton 

yöntemi ile güçlendirilmesi tavsiye edilmiştir. Yapının mevcut durumu ile 

güçlendirildikten sonraki hali SAP 2000 uygulaması ile analiz edilerek sonuçlar 

karşılaştırılmıştır. Sonuç olarak yapının doğal titreşim periyodu şu anki halinde 0,195 sn. 

iken güçlendirilmiş hali ile 0,146 sn.’ye düşmüştür. Yani yapının rijitliği arttırılmıştır. 

Yapıda katlar arasındaki duvar süreksizlikleri yeni yığma duvarlar ilave edilerek ortadan 

kaldırılmış ve binanın taşıma gücünde zayıflık yaratan yerleri giderilmiştir. Terasları 

taşıyan 25x25 boyutlarındaki narin kolonlar mantolama uygulaması ile düşey ve yatay 

yüklere karşı güçlendirilmiştir. Bazı duvarlarda 10 cm kalınlığında hasır donatılı 
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betonarme güçlendirme kabuğu uygulanarak düzlem dışı yer değiştirme hareketleri 

azalmıştır. 

Vatan [6] tarafından 2005 yılında yapılan çalışmada, YTÜ Jeodezi ve Fotogrametri 

Mühendisliği Bölümü, Fotogrametri ve Uzaktan Algılama Anabilim Dalı tarafından Mimar 

Sinan’ın yapmış olduğu Eğrikemer'in fotogrametrik ölçümleri yapılmış ve üç boyutlu 

modeli oluşturulmuştur. Uygulama örneğinde sayısal veriler kullanılarak üç boyutlu 

düğüm noktası modeli ve üç boyutlu katı model, herhangi bir analiz programına bağlı 

kalınmadan oluşturulmuştur. Oluşturulan model daha sonra analiz programına 

aktarılmıştır. 

Özer [7] tarafından 2006 yılında yapılan çalışmada, yığma yapıların yapı elemanları 

incelenerek farklı açılardan analizleri yapılmıştır. Yapısal, biçimsel ve statik açıdan 

yapılan analizlerde, yapı elemanlarının biçimlerinden kesit tayinine, kullanılacak 

malzemelerden stabilite ilkelerine kadar birçok konu ele alınmıştır.  Sonuç olarak 

geleneksel yığma yapılarda yapı elemanların üzerindeki yüke bağlı olan itki çizgisinin, 

yapı elemanı üzerindeki yeri ve açısının önemi belirtilmiştir. 

Aytekin [8] tarafından 2006 yılında yapılan çalışmada, yönetmelik ve standartlara göre 

yığma yapı sınıfları ve hesap yöntemleri tanıtılarak, donatısız ve sarılmış yığma yapıların 

deprem davranışları karşılaştırılmıştır. Tuğla ve gaz betondan yığma yapı modelleri 

oluşturulmuş, Düzce depremi ivme kaydından yararlanılarak SAP2000 uygulamasında 

mod birleştirme yöntemi ile analizi yapılmıştır. Her iki malzemeden oluşan yapı modelleri 

için donatısız ve sarılmış durumları ele alınarak elde edilen kesit tesirleri, yer değiştirme 

değerleri tablo ve grafikler halinde karşılaştırılmıştır. Ardından maliyet hesapları 

yapılmıştır. Donatısız ve sarılmış yığma yapı modelleri için seçilen düğüm noktalarının 

yer değiştirme miktarları karşılaştırıldığında genelde sarılmış durumda daha az yer 

değiştirme olduğu gözlemlenmiştir. Maliyet analizlerinde ise sarılmış durumdaki 

modeller için maliyetin yaklaşık %18 oranında artığı tespit edilmiştir. Buna rağmen 

sarılmış yığma yapıların depremde daha az hasar aldığı tespit edilmiştir. Onarım ve 

güçlendirme maliyetinin çok yüksek olduğu göz önünde bulundurularak sarılmış yığma 

yapıların tercih edilmesinin daha uygun olacağı kanaatine varılmıştır. 

Özen [9] tarafından 2006 yılında yapılan çalışmada, Hasankeyf’te yer alan yığma bir 

yapının modelli oluşturulmuştur. Sonlu elemanlar yönteminde kullanılan farklı 
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uygulamalar ile gerilmeler, şekil değiştirmeler ve mod şekil değiştirmeleri kullanılarak 

karşılaştırma yapılmıştır. Ayrıca yapının doğrusal analizi yapılmış ve doğrusal olmayan 

davranışla karşılaştırması yapılmıştır. Sonuçlar karşılaştırıldığında benzer değerler elde 

edilmiştir. Tüm yapının incelenmesinde doğrusal analizin, doğrusal olmayan analiz için 

yeterli bir alternatif olduğu görülmüştür. 

Bayraktar [10] tarafından 2006 yılında yapılan çalışmada, tarihi yapılarda oluşan hasarlar 

ve bu hasarların nedenleri ile farklı tipteki tarihi yapılar için uygun olan sismik 

güçlendirme metotları hakkında bilgi verilmiştir. 

Mahrebel [11] tarafından 2006 yılında yapılan çalışmada, tarihi yapı türleri, yığma 

yapılardaki kullanılan malzemeler, yığma yapıların taşıyıcı sistemlerinin özellikleri, 

deprem güvenliğinin incelenmesi, oluşan hasarlar ve türleri ile onarım ve güçlendirme 

yöntemleri konuları ele alınmıştır. 

Şen [12] tarafından 2006 yılında yapılan çalışmada, tarihi yığma yapıların modellemesi 

ve analiz metotları hakkında bilgiler verilmiştir. Çalışmanın yapıldığı sırada 105 yaşında 

olan Hemdat İsrail Sinagogu model olarak belirlenmiştir. Bu amaçla sinagog düşey ve 

yatay yükler altında incelenmiştir. Binanın tepkisinin değerlendirilmesi için Sap 2000 

uygulaması (9.1 sürümü) ile doğrusal analiz yapılmıştır. Ayrıca yığma yapılarda geniş 

pencere çerçevelerinin yapının sismik davranışına etkisi incelenmiştir. Bu amaç 

doğrultusunda pencere çerçeveli ve pencere çerçevesiz olmak üzere iki farklı model 

oluşturulmuş ve analizi yapılmıştır. Yapı elemanlarının gereken dayanımı, malzemelerin 

varsayılan elastik kapasiteleri ile karşılaştırılmıştır. Analiz sonuçlarına göre Hemdat İsrail 

Sinagogu sismik hareketlere karşı yeterli dayanıma sahip değildir. Sismik hareketler 

sırasında dış duvarlarda yıkılma olabileceği tespit edilmiştir. Sismik bir hareket olmasa 

bile yapı tehlike altında olduğu kanaatine varılmıştır. Analiz sonucu yüksek gerilmelerin 

olduğu bölgelerde gerçek yapı üzerinde de hali hazırda mevcut çatlakların olduğu 

gözlemlenmiştir. 

Sesigür vd. [13] tarafından 2007 yılında yapılan çalışmada, tarihi yığma binalar için 

onarım ve güçlendirme prensiplerinin adımları ve yöntemleri, yığma kâgir yapılarda 

taşıyıcı bileşenler ile yapı güvenliği hakkında bilgiler verilmiştir. 
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Yıldırım [14] tarafından 2007 yılında yapılan çalışmada, literatürde deney sonuçları var 

olan prizmaların blok, harç ve dolgu malzemesi etkin olacak şekilde 3 boyutlu sonlu 

eleman modelleri LUSAS programında yapılmıştır. Modeli gerçekleştirilen prizmaların 

elastik analizlerinde Drucker-Prager kırılma kıstasları ve izotropik hasar modeli (Oliver 

modeli) kullanılmıştır. Bu analizler sonucunda, blok, harç ve dolgu betonun dayanımına 

bağlı olarak Drucker-Prager kırılma kıstaslarının malzeme parametreleri olan kohezyon 

ve içsel sürtünme açısı ve malzeme hasar parametresi değerleri için bağıntılar 

önerilmiştir. Bu analizlerin sonuçları kullanılarak içi boş ve içi dolu prizmaların basınç 

dayanımlarını tahmin etmeye yönelik iki bağıntı önerilmiştir. Son olarak Yıldız Teknik 

Üniversitesi laboratuvarlarında içi boş ve içi değişik dayanıma sahip dolgu betonu ile 

doldurulmuş prizmaların deneyleri yapılmıştır. 3 boyutlu doğrusal olmayan sonlu eleman 

analizleri yapılmıştır. Bu analizlerin sonuçları ile deney ve önerilen bağıntıların sonuçları 

karşılaştırılmış ve sonuçların uyumlu olduğu görülmüştür. 

Aköz [15] tarafından 2008 yılında yapılan çalışmada, tarihi yığma yapıların onarım ve 

güçlendirilmesi konusu hakkında bilgi verilmiş, örnek bir tarihi yığma yapının üç boyutlu 

sonlu eleman modeli oluşturularak statik ve dinamik analizleri yapılmış, deprem 

güvenliği belirlenip güçlendirme ihtiyacı ve yöntemi tartışılmıştır. 1400’lü yıllarda yapılan 

Murat Paşa Camii’nin üç boyutlu sonlu eleman modelinin statik ve dinamik analiz ve 

sonuçları, elde edilen diyagramlarla anlatılmış, mevcut güvenlik düzeyi irdelenmiş ve 

güçlendirme yöntemleri tartışılmıştır. Yapıdaki en büyük yer değiştirme, büyük kemerin 

tepe noktasında düşey doğrultuda 1.5 mm, en büyük gerilme ise yine aynı noktada olup 

0.35 MPa olarak hesaplanmıştır. Modal spektral analiz neticesinde yapının X 

doğrultusunda etki eden depremde Y doğrultusundakine göre daha fazla şekil 

değiştirdiği ve gerilmelerin daha fazla olduğu gözlemlenmiştir.  

Dabanlı [16] tarafından 2008 yılında yapılan çalışmada, tarihi yığma yapıların deprem 

performansının belirlenmesi konusu ele alınmıştır. Örnek yapı üzerinde çalışmadan ve 

değerlendirme çalışmalarına başlamadan önce yapılması gereken hazırlıklar, tarihi 

araştırmalar, malzeme özelliklerinin belirlenmesi, zemin özellikleri, tarihi yığma yapıların 

sayısal olarak modellenmesi ve analiz metotları üzerinde durulmuştur. Daha sonra Hırka-

i Şerif Camii için üç boyutlu sayısal analiz modeli oluşturulmuştur. Modelin çeşitli 

yükleme durumları için sayısal çözümü yapılmış, sırasıyla düşey yükler altında statik 



6 
 

analiz, modal analiz ve davranış spektrumu analizleriyle yapının performansı, gerilmeler 

ve yer değiştirmeler yoluyla değerlendirilmiştir. Hırka-i Şerif Camii’nde meydana gelen 

hasarların büyük bir bölümünün zemin hareketlerinden kaynaklandığı tespit edilmiştir. 

Camii zemininde yapılan sondaj ve muayene çalışmalarından anlaşıldığı üzere, yapı dolgu 

bir zemin üstünde bulunmasına rağmen 4 m aşağıya uzanan temeller, Süleymaniye 

Formasyonu olarak bilinen dolgu altındaki tabakaya oturtulmuştur. Dolgu zemin 

tabakasının yaptığı oturmaların da yapının taban döşemesinde 5–10 cm mertebelerinde 

oturmalara sebep olduğu tespit edilmiştir. Model üzerinde gerçekleştirilen analizlerden 

elde edilen verilere göre yapı, genel olarak (minareler hariç) her hangi bir yapısal tehlike 

barındırmamaktadır. Minareler yer değiştirmeler yönüyle, tepe noktasında yaklaşık 15-

20 cm’yi bulan yer değiştirmeyle Kültürel Değerin Korunması performans seviyesindedir. 

Gerilmeler açısından değerlendirildiği zaman ise minareler göçmenin önlenmesi 

performans düzeyinde görülmektedir. Düşey yükler altında yapılan statik analiz 

sonucunda, yapının düşey (zati, hareketli ve kar yükleri) yükleri güvenli olarak taşıdığı 

sonucuna varılmıştır.  Hırka-i Şerif Camii’nin G+Q düşey yükleri altında güvenli olduğu 

tespit edilmiştir. Deprem yüklerinde, mahfillerde özellikle sütunların üzerinde yer alan 

kısımda büyük yer değiştirmeler tespit edilmiştir.  Ayrıca yapı için güçlendirme 

önerilerinde bulunulmuştur. 

Gedik [17] tarafından 2008 yılında yapılan çalışmada, tarihi yığma yapıların malzeme 

özellikleri, elemanları, bu yapılarda oluşan hasarlar ve bunların onarım ve 

güçlendirilmesi hakkında özet bilgi verildikten sonra, tarihi Mehmet Ağa Camii üzerinde 

incelemeler yapılmıştır. Yapının modeli oluşturulmuş ve kendi ağırlığı ile deprem yükleri 

altında analizi yapılmıştır. 50 yılda aşılma olasılıkları %2 ve %10 olan iki farklı deprem 

yüklemesi kullanılmıştır. Mevcut hasarların nedenlerini belirlemek amacıyla özellikle 

çekme gerilmesi bölgeleri araştırılmış ve mevcut hasarlarla karşılaştırması yapılmıştır. 

Gelecekteki olası hasarların önlenmesi için bazı onarım ve güçlendirme önerilerinde 

bulunulmuştur. 

Sato vd. [18] tarafından 2008 yılında yapılan çalışmada Kocaeli depremi öncesi ve sonrası 

Süleymaniye Camii, Ayasofya Müzesi, Şehzade Camii ve yeni yapılmış bir ofis binasının 

doğal titreşim frekansları incelenmiş ve Kocaeli depreminin doğal titreşim frekanslarını 

ne kadar değiştirdiği üzerine çalışılmıştır. Sonuçlara göre yaklaşık 500 sene önce yapılmış 
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olan Süleymaniye Camii’nin % 2.8, yaklaşık 1500 yıl önce yapılmış olan Ayasofya 

Müzesi’nin % 8.9, yaklaşık 500 sene önce yapılmış olan Şehzade Camii’nin % 4.8 ve yani 

yapılmış ofis binasının ise % 8.5 oranında doğal titreşim frekanslarının değiştiği ortaya 

çıkmıştır. 

Kara [19] tarafından 2009 yılında yapılan çalışmada, tarihi yapılarda en çok rastlanılan 

yığma yapı yapım tekniği incelenmiş, tarihi yığma yapıların taşıyıcı sistemleri, kullanılan 

malzemeler tanıtılmış, yürürlükteki deprem yönetmeliği koşullarına göre yığma yapı 

tasarım ilkelerine değinilmiş ve yığma yapılarda oluşan hasar türleri ve onarım 

güçlendirme teknikleri incelenmiştir. Ele alınan örnek yapılarla ilgili tahkikler ve sayısal 

hesaplamalara yer verilmiştir. 

Öztaş [20] tarafından 2009 yılında yapılan çalışmada, mevcut bir yığma yapı ele alınarak 

analizi yapılmıştır. Daha sonra bu yapıya betonarme güçlendirme perdeleri eklenerek 

tekrar analiz edilmiştir. Son olarak cam lifli polimerlerle (GFRP) güçlendirilerek üçüncü 

bir analiz yapılmış ve yer değiştirmeler ile momentlerin karşılaştırması yapılmıştır. Sonuç 

olarak betonarme perdeler veya GFRP ile güçlendirilmiş yığma yapıda yer 

değiştirmelerde ciddi azalmalar görülmüştür. Karşılaştırma sonuçlarına bakıldığında 

betonarme perde ilave edildiğinde sistemin X doğrultusundaki yer değiştirmesinde 

mevcut yapının yer değiştirmesine göre yaklaşık 4 kat, Y doğrultusundaki yer 

değiştirmesinde mevcut yapının yer değiştirmesine göre yaklaşık 9 kat azalma olmuştur. 

GFRP’li güçlendirme yapıldığında ise sisteminin X doğrultusundaki yer değiştirmesinde 

mevcut yapının yer değiştirmesine göre yaklaşık 1.5 kat, Y doğrultusundaki yer 

değiştirmesinde mevcut yapının yer değiştirmesine göre yaklaşık 4 kat azalma olmuştur. 

Betonarme perdeyle güçlendirilmiş yapı ile mevcut yapının moment kapasiteleri 

karşılaştırıldığında ise bina genelinde mevcut sisteme göre 8 yığma duvarın moment 

taşıma kapasitesinde artış olmuştur. Lifli polimerle (GFRP) güçlendirilmiş yapının 

tamamındaki taşıyıcı yığma duvarlarda moment yetersizliği görülmüştür. Yer 

değiştirmeler açısından incelendiğinde GFRP güçlendirme sistemi, betonarme perdelerle 

yapılan güçlendirme sistemine göre binada daha fazla yer değiştirme oluşturmuştur. 

Moment kapasiteleri açısından incelendiğinde betonarme perdelerle güçlendirilmiş 

sistem yığma duvarların moment kapasitesini olumlu yönde etkilemiştir. Betonarme 

perdelerle güçlendirme sistemi yapının deprem dayanımını arttırmış, yapının diğer 
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sistemlere göre daha az yer değiştirme yapmasını sağlamıştır. GFRP ile güçlendirilmiş 

yığma duvarlı sistemin moment kapasitelerine olumlu yönde etkisi betonarme sistemin 

altındadır. Ayrıca betonarme ile güçlendirilmiş sisteme göre daha fazla yer değiştirme 

yapmaktadır. Bu durumun statik açıdan yeterli olması halinde özellikle tarihi yapılarda 

tercih edilmesi gerektiği vurgulanmıştır. 

Ural [21] tarafından 2009 yılında yapılan çalışmada, yığma yapı sistemleri, kullanılan 

malzemeler, ilgili yönetmelik ve standartlar ile yığma yapıların statik ve dinamik yükler 

altındaki davranışları doğrusal ve doğrusal olmayan yanlarıyla ele alınmıştır. Geliştirilmiş 

olan bir adet pratik deprem hesabı programı ile birlikte LUSAS ve DIANA programları 

yardımıyla çeşitli analizler gerçekleştirilmiştir. Yığma duvar dayanımlarını ve yığma 

yapıların deprem davranışlarını etkileyecek olan bazı parametreler yapısal modeller 

yardımıyla incelenmiştir. Ayrıca depremde hasara uğramış gerçek bir yığma yapının 

analizleri yapılmıştır. Dolu gövdeli yığma duvar uzunluklarının taşıma kapasitesine olan 

etkilerinin incelendiği çalışmadan elde edilen sonuçlara göre, dolu gövdeli duvar 

uzunluğu ortalama olarak 1,5m-1,8m arasındaki mesafelerdeki duvarlar optimum 

taşıma kapasitesine sahip duvarlar olarak tespit edilmiştir. Balâ depreminde ağır hasara 

uğrayan tuğla bir yığma yapının statik ve dinamik analizleri yapılmıştır. Yapıda düşey ve 

yatay hatılların mevcut olmayışından dolayı hasara uğramış olduğu gözlemlenmiştir. 

Tuğlalar arasındaki harcın çekme dayanımının çok düşük olmasının meydana gelen 

hasaların önemli bir etken olduğu tespit edilmiştir. Yapılan doğrusal olmayan analizler 

sonucunda binada meydana gelen çatlaklar, oluşturulan modelde de elde edilmiştir. Balâ 

depremindeki yapısal hasarların incelenmesi üzerine statik, modal, tepki spektrumu ve 

zaman-tanım alanında analizler yapılmış, daha sonra basitleştirilmiş mikro modelleme 

yöntemiyle iki farklı duvarın doğrusal olmayan analizleri gerçekleştirilmiştir. Elde edilen 

sonuçlara bakıldığında doğrusal olmayan analizlerden elde edilen verilerin, gerçekte 

yapıdaki hasarları yorumlamada daha iyi sonuç verdiği gözlemlenmiştir. 

Ulukaya [22] tarafından 2009 yılında yapılan çalışmada, ikiz iki konuttan oluşan tarihi 

yığma yapının taşıyıcı duvarları bodrum katta taş, üst katlarda tuğla ile inşa edilmiştir. 

İnşa edildiği dönemde mesken olarak kullanılması düşünülen yapıda betonarme, çelik ve 

ahşap gibi farklı taşıyıcı ve bağlayıcı sistemleri bulundurması nedeniyle üzerinde 

çalışılmaya değer bir yapı olduğu düşünülmüştür. Yapının malzeme ve yapım teknikleri 
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irdelenmiş, yapıda bulunan hasarlar belgelenerek rölövesi oluşturulmuştur. Yapıda 

mevcut bulunan hasarların nedenlerini tespit etmek ve yapının deprem güvenliğini 

oluşturmak üzere 3 boyutlu modeli oluşturulmuştur. Analitik yöntemlerle ayrı ayrı statik 

çözümlemeler yapılmış ve elde edilen sonuçlar karşılaştırıldığında yapının düşey ve yatay 

gerilmeler karşısındaki davranışı ve zayıf noktaları tespit edilmiştir. Yapının strüktürel 

özgün konut işlevini sürdürebilmesi için restorasyon projesi hazırlanmıştır. 

Sayın [23] tarafından 2009 yılında yapılan çalışmada, yığma duvarlar için doğrusal ve 

doğrusal olmayan statik ve dinamik analiz yapabilen bir uygulama oluşturulmuştur. 

Yazılan uygulama MATLAB üzerinden yapılmıştır. Duvar malzemesi için şekil değiştirme 

yumuşamasını göz önünde bulunduran yayılı çatlak modeli kullanılmıştır. Ayrıca yine 

MATLAB ile duvarın iki ve üç boyutlu sonlu eleman modelini oluşturan bir mesh programı 

oluşturulmuştur. Statik artımsal analiz için pencere boşluğuna sahip bir duvarın sol üst 

köşesindeki ilgili düğüm noktasına x yönünde artımsal yük uygulanmıştır. Doğrusal 

olmayan dinamik analiz için ise Erzincan (1992) ve Bingöl (2003) depreminin ivme 

kayıtları kullanılmıştır. Öncelikle yazılan programın doğruluğunu test etmek amacıyla; 

örnek duvarın lineer ve lineer olmayan dinamik analizleri yapılmış mevcut paket 

programın sonuçlarıyla karşılaştırılarak yazılan programın doğruluğu onaylanmıştır. 

Ardından örnek duvar için parametrik çalışmaya geçilmiştir. Duvarın malzeme ve boyut 

parametrelerine bağlı olarak statik artımsal analizleri ile lineer olmayan dinamik 

analizleri yapılmış, dinamik analizlerde söz konusu deprem ivme kayıtları 

ölçeklendirilerek (0.8, 1.0 ve 1.2) kullanılmıştır. Statik artımsal analiz için yapılan 

çözümler incelendiğinde, yığma duvarlarda deprem etkisiyle oluşan diyagonal 

çatlaklarda olduğu gibi, duvarın üst kısmı ile pencere köşe kısımlarından başlayarak 

yükün şiddetine bağlı olarak çatlakların duvar içinde ilerlediği gözlemlenmiştir. Farklı 

çekme dayanımlarına sahip yığma duvarlarda oluşan hasar durumu incelendiğinde, 

duvarlarda meydana gelen hasarların benzer bölgelerde meydana geldiği fakat 

malzemenin çekme dayanımının azalmasına bağlı olarak hasarın büyüdüğü ve daha hızlı 

yayıldığı gözlenmiştir. Yığma duvarda bulunan pencere boşluğu miktarının artışına bağlı 

olarak duvarda meydana gelen hasar durumunun incelendiği çalışmada, yedi farklı 

model oluşturulmuştur. Analiz sonuçlarına göre hasarın daha çok pencere boşluğu ve 

duvar köşelerinde yoğunlaştığı ve duvar içindeki boşluk miktarının artmasıyla hasar 
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bölgesinin büyüdüğü ve daha hızlı yayıldığı ayrıca duvar içinde yeni hasar bölgelerinin 

oluştuğu gözlemlenmiştir. Yığma duvara değişik konumlarda yerleştirilen hatılların 

çatlak yayılışını ve hasar biçimini etkilemekte olduğu görülmüştür. Ayrıca, bu hatılların 

duvarda oluşan hasar bölgelerini sınırlanmasına ve yayılış doğrultusunun değişmesine 

sebep olduğu gözlemlenmiştir. Doğrusal analizdeki maksimum asal gerilmelere ait pik 

değerlerin malzemenin çekme dayanımını aşarak malzemede çekme kırılmasına sebep 

olabildiği, minimum asal gerilmelerin pik değerlerinin ise malzemenin basınç 

dayanımının altında kaldığı tespit edilmiştir. Yer değiştirme ve asal gerilmelerin zamana 

bağlı grafiklerine bakıldığında her iki depremin ivme kayıtları için duvarda ilk çatlak 

oluşana kadar lineer ve lineer olmayan dinamik çözümlerin aynı olduğu görülmüştür. 

Çatlakların artmasıyla birlikte doğrusal ve doğrusal olmayan çözümler arasındaki 

farkların belirgin hale geldiği gözlemlenmiştir. Çatlaklar, genellikle duvardaki pencere 

köşelerinde ortaya çıkmakta ve dinamik etkiye bağlı olarak pencere boşluğu ile duvar 

köşeleri arasında yayılarak genişlemektedir. İvme genlik katsayısının artışı duvardaki ilk 

çatlak anını küçültmekte ve ivme genlik katsayısının artışına bağlı olarak çatlak yayılım 

hızı ve yayılma bölgesinin büyüme gösterdiği tespit edilmiştir. Depremler neticesinde 

elde edilen çözümler birbirleriyle karşılaştırıldığında; gerek tepki büyüklüklerinin 

zamanla değişimleri gerekse hasar bölgelerinde oluşan çatlak yoğunlaşması farklılık 

göstermektedir. Farklı deprem kayıtları için duvarda meydana gelen ilk çatlak yeri ve 

zamanı değişiklik göstermiştir. Sonuç olarak, deprem karakteristiklerinin çözümleri 

önemli ölçüde etkilediği görülmüştür. 

Türker [24] tarafından 2010 yılında yapılan çalışmada, tarihi yığma yapılar incelenmiş, 

tanıtılmış, strüktürel davranışı açıklanmış ve Türk Deprem Yönetmeliği’nde belirtilen 

esaslar üzerine EXCEL formatında bilgisayar programı oluşturulmuştur. Bu program ile 

İstanbul Üniversitesi Eczacılık Fakültesi binasının deprem analizleri yapılmıştır. Malzeme 

özelliklerinin belirlenmesi için örnek binayla aynı dönem (19 yy) ve aynı yapım tekniği ile 

yapılmış Ali Fakih Sıbyan Mektebi ve Abdülmecit Evi’nden alınan numunelerle İstanbul 

Büyükşehir Belediyesi, Koruma Uygulama ve Denetim Müdürlüğü (KUDEB) 

laboratuvarlarında deneyler yapılmıştır. Yığma duvarın dinamik davranışı ve SAP2000 

uygulamasında tipik bir duvarın davranışı gözlemlenmiştir. Örnek yapının özgün 

durumunda tüm duvarların basınç dayanımlarının basınç emniyet gerilmelerini aşmadığı 



11 
 

görülmüştür. Çoğu duvarın kayma gerilmelerinin ise kayma emniyet gerilmesini aştığı 

gözlemlenmiştir. Yapı duvarlarının basınç emniyet gerilmelerini aşmadığı ama 

birçoğunun da kayma emniyet gerilmelerini aştığı tespit edilmiştir. Kayma emniyet 

gerilmelerinin aşılmasında kat yüksekliklerinin fazla olması ve duvar kalınlıklarının az 

olmasının etkisinin büyük olduğu kanaatine varılmıştır. Yapıda rijitlik ve kütle 

merkezlerinin çakışmamasından dolayı büyük burulma momentlerinin oluştuğu tespit 

edilmiştir. 

İspir [25] tarafından 2010 yılında yapılan çalışmada, 19. yy’da yapılan tarihi bir yığma 

yapı olan, Akaretler Sıraevler Grubu'nun taşıyıcı duvarlarından alınan numuneler 

üzerinde deneysel çalışma yapılmıştır. Taşıyıcı duvarlarından alınan tarihi tuğla ve harç 

örnekleri üzerinde mekanik, fiziksel ve kimyasal deneyler yapılmıştır.  Tuğla ve harç 

örneklerinin eğilmede çekme ve basınç dayanımları deneysel olarak tespit edilmiştir. 

Tarihi malzemenin, günümüz malzemesine göre daha düşük dayanımlı olduğunu 

sonucuna varılmıştır. Mevcut taşıyıcı duvarlarından karot ve duvar parçacıkları 

çıkarılmış, karotlar üzerinde yarma, basınç ve kayma deneyleri gerçekleştirilmiş ve duvar 

parçacıkları ise monotonik ve tekrarlı basınç yüklemeleri altında test edilmiştir. Prizma 

ve duvar numuneleri üzerinde basınç ve kayma deneyleri yapılmıştır. Deneyler 

neticesinde, ilgili dayanım ve deformasyon özellikleri elde edilmiştir.  Sonlu elemanlar 

programı (Abaqus) kullanılarak elde edilen prizma ve duvarın basınç gerilmesi-düşey 

şekil değiştirme ilişkileri, deneysel olarak elde edilen ilişkilerle karşılaştırılmıştır. Sonlu 

eleman analizinin, numunelerin basınç dayanımlarını tahmin etmede başarılı olduğu 

gözlemlenmiştir. 

Ercan [26] tarafından 2010 yılında yapılan çalışmada, tarihi yığma yapıların 

güvenliklerinin belirlenmesinde kullanılan analitik ve deneysel yöntemlerin, İzmir’de 

bulunan iki örnek yığma yapıda uygulamasına yer verilmiştir. Tarihi yığma yapıların 

malzeme özelliklerini belirlemede kullanılan deneysel yöntemler, Vezir Su Kemeri ve 

Urla Zeytinler Köyü’nde bulunan tarihi taş kemer köprüde uygulanmıştır. Yapıların 

malzeme özelliklerini belirlerken yapılar üzerinde tarihsel inceleme, tahribatlı ve 

tahribatsız malzeme testleri, dinamik inceleme, darbe-eko yöntemleri uygulanmıştır. 

Yapıların bulunduğu bölgelerde ise, zemin incelemeleri ile mikrotremor ölçümler 

yapılmış ve bölgelerin depremselliği gözlemlenmiştir. Yapıların taşıyıcı sistemini 
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oluşturan taş, tuğla ve harç üzerinde yapılan malzeme testleri ile malzeme parametreleri 

elde edilmiştir. Bu özellikler kullanılarak yığma yapıların sonlu elemanlar yöntemi ile 

modal analizi yapılmış ve dinamik karakteristikleri elde edilmiştir. Ele alınan tarihi 

yapılara Operasyonel Modal Analiz uygulaması yapılmış ve deneysel dinamik 

karakteristikleri tespit edilmiştir. Deneysel ve analitik yöntemlerle bulunan dinamik 

sonuçlar karşılaştırılarak, malzeme testlerinin yeterliliği tartışılmıştır. Elde edilen 

sonuçlarla yapıların doğrusal olmayan statik analizleri ve dinamik analizleri yapılmış ve 

yapıların güvenilirliği tartışılmıştır. 

Kaya [27] tarafından 2010 yılında yapılan çalışmada, donatısız yığma duvarların doğrusal 

olmayan analizi ile ilgili modelleme teknikleri hakkında bilgi verilmiştir. Donatısız yığma 

duvarların iki ve üç boyutlu elastik-plastik modellemeleri yapılmış, plastik aşamada 

kullanılan kırılma modelinin ihtiyaç duyduğu malzeme parametrelerinden kohezyon ile 

ilgili parametrik bir araştırma yapılmıştır. Bu bağlamda, literatürde yer alan örnek bir 

donatısız yığma duvarın, farklı sonlu eleman tipleri ile çalışan mikro ve makro modelleme 

tekniği ile numerik modeli oluşturulmuş, doğrusal olmayan sonlu eleman analizleri, 

Drucker-Prager kırılma kriterinin belirlemiş olduğu akma yüzeyi kullanılarak LUSAS 

(sürüm 13) programında gerçekleştirilmiştir. 

Arıcan [28] tarafından 2010 yılında yapılan çalışmada, tarihi değeri olan yığma yapıların 

deprem davranışlarının belirlenmesi amacıyla Isparta’da bulunan yedi tarihi yığma yapı 

ele alınarak deprem davranışı açısından incelenmiştir. Toplam 42 yığma yapı modeli ile 

20 farklı özelliğe sahip deprem kayıtları kullanılarak herhangi bir depremde ortaya 

çıkabilecek farklı durumlar üzerine çalışılmıştır. Modeller SAP2000 uygulaması 

kullanılarak oluşturulmuş ve yığma yapıların, zaman tanım alanında dinamik analizleri 

gerçekleştirilmiştir. Bulunan sonuçlar karşılaştırmalı olarak değerlendirilip tartışılmıştır. 

Tek katlı, iki katlı ve üç katlı modellerin ayrı ayrı yer değiştirme ve taban kesme kuvvetleri 

ile ilgili grafikleri, göreli kat ötelemeleri ve farklı malzemeler açısından grafikleri 

verilmiştir. Yapı modellerine ait gerilme şekilleri de görsel olarak hazırlanmıştır. Analiz 

sonucunda tüm modellerin yer değiştirme ve taban kesme kuvvetleri sayısal değer 

olarak tespit edilmiş ve grafikler oluşturulmuştur. Analizlerde iki katlı ve üç katlı modeller 

için her katın ayrı ayrı analizi yapılmış ve göreli kat ötelemeleri tespit edilmiştir. 

Toplamda 1680 tane analiz gerçekleştirilmiştir. Sonuçlara bakıldığında bütün yığma 
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yapıların tuğla malzemeli modellerindeki yer değiştirmelerin doğal taştaki yer 

değiştirmelere göre çok daha fazla olduğu tespit edilmiştir. Bütün doğal taş modellerde 

ise taban kesme kuvveti değerleri tuğla modellere göre daha büyük çıkmıştır. Doğal taş 

yığma yapı modelleri, periyotlarının kısa olmasından dolayı depremlerde daha büyük 

yatay kuvvetlere maruz kaldıkları için, taban kesme kuvvetlerinin büyük çıktığı 

gözlemlenmiştir. Taban kesme kuvvetleri büyük olmasına rağmen rijit olmasından dolayı 

hareket etme kabiliyeti düşük olduğu için, yer değiştirme değerleri tuğla modellere göre 

daha düşük çıkmıştır. Yapı modellerinin tümüne bakıldığında ve 1. deprem olan Cape 

Mendico CPM-UP ve 7. deprem olan Landers LCN-UP, 12. deprem olan Morgan Hill 

CYC285 depremlerinde en büyük ilk üç yer değiştirme ve taban kesme kuvveti 

değerlerinin elde edildiği tespit edilmiştir. En büyük değerler bu üç deprem arasında 

gözlemlenmiştir. Depremlerin özelliklerine bakıldığında ise en büyük ilk üç yer 

ivmelerine sahip depremlerdir. 

Şeker [29] tarafından 2011 yılında yapılan çalışmada, cami yapım teknikleri, kullanılan 

malzemeler ve özellikleri incelenmiştir. Mimar Sinan tarafından yapılan 28 adet caminin 

üç boyutlu modelleri oluşturularak statik ve dinamik analizleri yapılmıştır. Analiz 

sonuçlarına göre bazı oranlar ve parametreler belirlenerek davranış üzerindeki 

etkinlikleri irdelenmiştir. 

Akdeniz [30] tarafından 2011 yılında yapılan çalışmada, tarihi yapılarda taşıyıcı sistem 

elemanları ve kullanılan malzemeler hakkında bilgiler verilmiştir. Tarihi yapılarda oluşan 

hasarlar, onarım ve güçlendirme ile yığma yapılarda kullanılan modelleme yöntemleri 

hakkında kısa bilgiler verilmiştir. Çalışmada 1224 yılında yapılan, tarihi yığma yapı olan 

Malatya Ulu Camii’nin doğrusal ve doğrusal olmayan analizleri Bingöl (2003) depremi 

ivme kayıtları kullanılarak yapılmıştır. Cami, sonlu elemanlar yöntemine göre 

modellenmiş ve ANSYS uygulaması yardımıyla analizleri yapılmıştır. Sonuçlar grafikler 

halinde sunularak değerlendirilmiştir. Doğrusal olmayan analizde camide çekme 

gerilmelerinin fazla olduğu bölgelerde çatlaklara bağlı oluşan hasarların yoğunlaştığı 

görülmüştür. Çatlakların çekme gerilmelerinin büyük değerler aldığı kemer-duvar 

birleşim bölgelerinde, duvar birleşim bölgelerinde ve duvar-temel birleşim ara yüzeyinde 

yoğunlaştığı tespit edilmiştir. Minaredeki çatlaklar ise, genelde minarenin orta kısmında 
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ve minare-cami duvarı birleşim bölgesinde daha çok meydana gelmiştir. Minaredeki 

hasarlarda devrilme momentinin önemli etkisinin olduğu kanaatine varılmıştır. 

Çırak [31] tarafından 2011 yılında yapılan çalışmada, yığma yapılarda oluşabilecek hasar 

şekilleri, geçmişte yapılan çalışmalar da irdelenerek ortaya konulmuş ve bu hususta bazı 

önerilerde bulunulmuştur. 

Atabey [32] tarafından 2007 yılında yapılan çalışmada, Sivas’ın Suşehri ilçesindeki yığma 

yapı olarak yapılmış olan Aşağısarıca İlköğretim Okulu binasının deprem performans 

analizi 2007 Deprem Yönetmeliği esaslarına göre analitik yöntem ve StatiCAD-Yığma 

uygulaması ile yapılmıştır. Elde edilen sonuçlara göre yapının performansı tespit 

edilmiştir. Bunun dışında ayrıca StatiCAD-Yığma uygulaması ile analitik hesap sonuçları 

da karşılaştırılmıştır. Hem analitik yöntem sonucunda, hem de StatiCAD-Yığma 

uygulaması ile yapılan analizler neticesinde, 2007 deprem yönetmeliği ile yapının göçme 

durumunda olduğu tespit edilmiştir. 

Köseoğlu [33] tarafından 2008 yılında yapılan çalışmada, 16. yüzyıl klasik Osmanlı 

mimarisinde tek kubbeli hasarlı bir cami üzerinde çalışılmıştır. Kubbede ve taş duvarlarda 

gözlemlenen aşırı çatlaklar caminin kapatılmasına neden olmuştur. Çalışmanın ana 

amacı hasarın olası sebeplerinin araştırılmasıdır. Cami siltli-kil üzerine inşa edilmiştir. Su 

tablasındaki değişime bağlı olarak siltli kil zeminde farklı oturmalara neden olmuştur. 

Yapının sonlu elemanlar modeli oluşturulmuştur. Taş duvarlar ise makro modellemeye 

göre homojen olarak kabuk elemanlarla modellenmiştir. Su tablası değişimi zemin 

oturması sebebiyle camiye temel mesnetlerinde deplasman olarak uygulanmıştır. 

Analizlerin sonuçları gözlemlenen gerçek hasarla karşılaştırılmış ve sonlu elemanlar 

modeli hasarla uyumlu olarak yeniden düzenlenmiştir. Zemin oturmasına bağlı 

deplasmanları engellemek için sert kaya zemine kadar mini fore kazık uygulaması 

önerisinde bulunulmuştur. Kubbedeki çatlakların ilerlemesini engellemek için kubbe 

kaidesi etrafına çelik plaka kasnağı konulması önerilmiştir. 

Karakuş [34] tarafından 2012 yılında yapılan çalışmada, geleneksel yığma yapılarda hasar 

türleri ve nedenleri, hasar tespit yöntemleri ve malzeme özelliklerinin belirlenmesi ile 

onarım ve güçlendirme yöntemleri hakkında bilgiler verilmiştir. 
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Gür vd. [35] tarafından 2012 yılında yapılan çalışmada, kâgir yığma duvarların malzeme 

ve bileşenlerin özellikleri, bunlarla üretilen duvarların yapım şekli ve yapı elemanı olarak 

özellikleri konularına değinilmiştir. 

Can Ve Ünay [36] tarafından 2012 yılında yapılan çalışmada, yapı mühendisleri 

tarafından geliştirilen sayısal modellerin ve yapılan hesapların mimarlar, restorasyon 

uzmanları ve mimarlık tarihçileri tarafından da kolaylıkla anlaşılmasının sağlanması 

amaçlanmış ve tarihi yapıların yapısal performansı ve dayanımını belirlemek için 

tavsiyelerde bulunulmuştur. 

Durutürk [37] tarafından 2012 yılında yapılan çalışmada, Isparta ili, Yalvaç ilçesinde 

bulunan 1912 yılında yapılmış tarihi bir yığma yapı olan Hamidiye Camii’nin, rölövesi esas 

alınarak, SAP2000 uygulamasıyla statik ve dinamik analizi yapılmış, taşıyıcı sistemin 

yapısal davranışı tespit edilmeye çalışılmıştır. Yapılan çözümler sonucunda basınç ve 

kayma gerilmeleri açısından en kritik bölgenin +2.00 kotu seviyesi olduğu belirlenmiştir. 

Bunun nedeni olarak ise bu kotta boşluk oranlarının diğer kotlara nazaran daha fazla 

olduğu kanaati getirilmiştir. Bütün kotlarda hesaplanan basınç ve kayma gerilmelerinin 

yönetmelikte verilen emniyet gerilmelerinin altında kaldığı, dolayısıyla binanın deprem 

kuvvetleri altında güvenli olduğu tespit edilmiştir. Kombinasyonlarda maksimum 

gerilmelerin, taşıyıcı taş duvarların birleşim bölgelerinde ve kapı- pencere boşluklarının 

bulunduğu yüzeylerde olduğu belirlenmiştir. Yapının fiziksel özellikleri ve DBYBHY 2007 

yönetmeliğinin verdiği sınır şartları ile Düzce (1999) depremi ivme kaydı kullanılarak 

yapılan statik ve dinamik analizlere bakıldığında yapının rijit taş duvarları, kat 

yüksekliğinin az oluşu ve üzerindeki çatının ahşap malzemeden yapılmış olmasının 

yapının günümüze kadar ulaşmasının temel sebepleri olduğu kanaatine varılmıştır. 

Sonuçlara bakıldığında yapının deprem yönetmeliğine göre güvenli olduğu 

belirlenmiştir. 

Kuruşcu [38] tarafından 2012 yılında yapılan çalışmada, yığma duvar ve temellerinde 

zemin-üstyapı etkileşimini de içine alan 3 boyutlu yapısal analizler yapılmıştır. Yığma yapı 

duvarlarının sonlu elemanlar yöntemi ile doğrusal olmayan analizleri yapılmıştır. 

Ardından yığma yapılarda zaman içinde kullanılan farklı temel türlerinin yatay yükler 

etkisindeki duvar davranışına etkisi irdelenmiştir. 



16 
 

Betti ve Galano [39] tarafından 2012 yılında yapılan çalışmada, tarihi yapıların analizi için 

disiplinler arası bir yaklaşım sunulmaktadır. İtalya’nın Pescia şehrindeki Vicarious Sarayı 

üzerinde yapılan statik analizler neticesinde yapının dikey yükler karşısında dayanımının 

yeterli olduğu ortaya çıkmıştır. Sismik analiz yapılırken uygulanan yaklaşım metodu 

global statik itme analizi ile basitleştirilmiş kinematik metodunun kombinasyonu 

şeklinde olmuştur. Analizler neticesinde yapının zayıf bölgeleri tespit edilmiştir. 

Ocakcan [40] tarafından 2013 yılında yapılan çalışmada, kâgir yığma sistemiyle inşa 

edilmiş kütüphanelerden farklı özelliklerde olanların plan özellikleri, cephe özellikleri, 

yapım teknikleri ve malzeme özellikleri ayrıntılı olarak incelenmiştir. I. Mahmut 

Kütüphanesi yapım teknikleri göz önüne alınarak, yapıda görülen bozulmalar ele alınmış 

ve 2008-2012 yılları arasında yapılan restorasyon uygulaması hakkında bilgiler 

verilmiştir. 

Lourenço [41] tarafından 2013 yılında yapılan çalışmada, mikro modelleme ve 

homojenizasyon tekniklerinden bahsedilmiştir. Şimdiki metotlar gözden geçirilmiştir. 

Avrupa yönetmeliklerinin (Eurocode 8) bazı düzenlemelere ihtiyacı olduğu kanaatine 

varılmıştır. Elde edilen sonuçların sadece yapının davranışını anlamada yardımcı olacağı 

ancak karmaşık yığma yapılarda doğrusal olmayan analiz yerine kinetik metoda göre 

limit analizin daha güvenli olduğundan bahsedilmiştir. 

Çavuş [42] tarafından 2013 yılında yapılan çalışmada, restorasyon çalışmalarında yeni 

malzeme ile geleneksel malzemenin birlikte kullanımından dolayı ortaya çıkan yapısal 

sorunlar göz önüne alınarak model bir yapı seçilmiş ve SAP2000 uygulamasında sonlu 

elemanlar yöntemiyle model oluşturularak analizler yapılmıştır. Yapılan bu analizlerle 

tarihi yapının deprem etkisi altındaki performansı irdelenmiştir. 

Erköseoğlu [43] tarafından 2014 yılında yapılan çalışmada, kuşatılmış ve donatısız yığma 

yapılar üzerinde gerçekleştirilmiş laboratuvar deneyleri ile üzerinde kaynak araştırması 

yapılmıştır. Sonrasında Tomazevic’in (1999) önerileri dikkate alınarak üç performans 

noktalı idealleştirilmiş üç doğrulu kapasite eğrileri tasarlanmıştır. Literatürde yer alan bu 

performans noktalarına bağlı ampirik denklemler araştırılmış ve deneysel davranışa en 

yakın sonucu verenleri idealleştirilmiş kuşatılmış ve donatısız yığma yapı davranışını 

temsil etmek üzere belirlenmiştir. Bu idealleştirilmiş analitik bilgi iki yığma yapı duvar 

tipinin davranışlarını karşılaştırmak amacıyla oluşturulan parametrik çalışma 
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kapsamında kullanılmıştır. Parametrik çalışmanın sonucunda kuşatılmış yığma 

duvarların davranışının donatısız yığma duvarlardan üstün olduğu tespit edilmiştir. 

Demirkan [44] tarafından 2014 yılında yapılan çalışmada, yığma yapılardaki faklı derz 

kalınlıklarının ve kullanılan taş boyutlarının yapının davranışı üzerindeki etkileri 

irdelenmiştir. Derz kalınlığı, taş örme tekniği gibi değişkenlere bağlı olarak yapının 

izotrop ve anizotrop malzeme tanımları ile analizi gerçekleştirilmiştir. Yapılan kabulün 

yapıya etkisinin ne ölçüde olacağı hakkında fikir sahibi olabilmek amacı ile izotrop ve 

anizotrop modellemenin analiz edilen örnek bir yapının analiz sonuçları ile 

karşılaştırması yapılmıştır. Aynı yapıda derz kalınlığının değişiminin ve taş diziliminde 

değişik ebatta malzeme kullanımının yapıya etkisi üzerinde de çalışılmıştır. Çalışma 

sonucunda derz aralarının 1cm yerine 2 cm yapılmasının duvarın elastisite modülüne 

etkisinin % 20 mertebelerinde, oluşan taban kesme kuvvetine etkisinin ise % 3 

mertebelerinde olduğu tespit edilmiştir. Taşıyıcı duvarların izotrop ya da anizotrop 

modellenmesinin gerek duvar mekanik özelliklerine gerekse yapı analizi sonucu bulunan 

değerlere etkisinin fazla olmadığı tespit edilmiştir. 

Çobanoğlu [45] tarafından 2014 yılında yapılan çalışmada, Türkiye’deki yığma yapıların 

malzeme özellikleri incelenmiş ve bu özelliklerin risk değerlendirme metotları üzerindeki 

etkisi araştırılmıştır. Çalışma için on bina belirlenmiş ve binalar hakkında detaylı bilgi 

toplamak amacı ile saha çalışması yapılmıştır. Öncelikle bütün binalar için 

yönetmeliklerde belirtilen yöntemle ön değerlendirme yapılmıştır ve sonuçlar 

irdelenmiştir. Daha sonra, laboratuvar ortamında sahadan alınan numuneler üstünde 

eksenel basınç, diyagonal çekme ve kayma deneyleri yapılmıştır. Deney sonuçları, 

DBYBHY’de verilen dayanım değerleriyle karşılaştırılarak incelenmiş ve yeni malzeme 

özellikleri önerilmiştir. Son olarak, seçilen binaların farklı malzeme özellikleri ve farklı 

deprem bölgeleri için yönetmeliklerde belirtilen yöntemle detaylı değerlendirmeleri 

yapılmıştır. Değerlendirme sonuçlarına göre deprem bölgelerinde yapılacak binalar 

hakkındaki yönetmelikte verilen malzeme özellikleri kullanıldığında hatalı ve güvenli 

olmayan sonuçların ortaya çıkabildiği gözlemlenmiştir. 

Çakıroğlu [46] tarafından 2014 yılında yapılan çalışmada, yalın ve çelik hasır üzerine 

polipropilen lifli kuru karışım püskürtme beton uygulaması ile güçlendirilmiş yığma 

duvarların tersinir düzlem dışı yük altındaki davranışlarının ve performanslarının 
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karşılaştırılması ve yığma yapıların güçlendirilmesinde polipropilen lifli ve çelik hasır 

donatılı püskürtme betonun kullanılabilirliği araştırılmıştır. Bu hedef doğrultusunda 

çalışmada 19 x 9 x 5 cm boyutlarında 2 adet seri halinde ve her bir seride 2 adet numune 

olmak üzere toplam 4 adet tuğla duvar numunesi hazırlanmıştır. Birinci seri yalın 

numune olmak üzere, ikinci seri çelik hasır üzerine 5 cm kalınlığında 5 kg/m3 polipropilen 

lif katkılı ve 2 kg/m3 püskürtme elyafı ilaveli kuru karışım püskürtme beton uygulaması 

yapılmıştır. 1 cm derz aralığında, şaşırtma örgüsü ile örülerek 220 x 245 cm boyutlarında 

üretilen tuğla duvarlara düzlem dışı yükleme uygulanıp tersinir yükleme yapılmış ve 

çalışma kapsamındaki her bir tuğla duvar numunesi için kırılma yükleri, çatlak ve kırılma 

rölöveleri ve artan yük kademelerinde yer değiştirme okumaları elde edilmiştir. 

Deneysel çalışmalar sonucunda; çelik hasır üzerine polipropilen lif katkılı kuru karışım 

püskürtme beton uygulaması ile güçlendirilmiş numunelerde yalın numuneye göre hem 

taşıma gücü yükü hem de enerji tüketme kapasitesi açısından artış sağlandığı 

görülmüştür. Hasır çelik üzerine polipropilen lif katkılı kuru karışım püskürtme beton 

uygulamasının mevcut yığma yapıların güçlendirilmesinde kullanılmasının hem taşıma 

gücü yükü hem de enerji tüketme kapasitesi bakımından uygun olduğu tespit edilmiştir. 

Saygılı [47] tarafından 2014 yılında yapılan çalışmada, ayrık elemanlar yöntemi ile 

modellenmiş yığma yapıların doğrusal olmayan dinamik analizi incelenmiştir. 1:10 

ölçeğinde yığma bir cami modeli inşa edilmiş ve model üç aşamalı bir program 

kapsamında, sarsma masası üzerinde test edilmiştir. Testler, sismik izolatör uygulaması 

yapılmış modelin testleri, modelin kendisinin test edilmesi ve güçlendirilmiş modelin 

testleri olmak üzere 3 aşamadır. Bu üç aşamanın sonuçları ayrık elemanlar yöntemi ile 

oluşturulan nümerik modellerin kalibrasyonunda kullanılmıştır. Ayrık elemanlar yöntemi 

ile oluşturulan ve üç farklı durum için doğrulanan nümerik modellerin gerçek yığma 

yapıların incelenmesi için yeterince iyi olduğu kanaatine varılmıştır. Daha sonra 

İstanbul'daki üç adet yığma minarenin dinamik davranışlarının sinüs dalgaları (hız genlik 

aralığı: 10 cm/s – 100 cm/s; frekans aralığı: 0.1 Hz – 13 Hz) ile gerçek ve simüle edilmiş 

deprem hareketleri altında incelemesi yapılmıştır. Yapısal hasar oluşumlarının analizi için 

minarelerde oluşan deformasyonlar ve yapısal sistemdeki enerji dengesi irdelenmiştir. 

Di Fabio vd. [48] tarafından 2015 yılında yapılan çalışmada, yığma yapı panellerinin 

kesme yükü altında davranışı incelenmiştir. Laboratuvar testleri, tarihi yığma yapıların 
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yapım tekniğine uygun ve aynı malzeme kullanılarak üretilen örnekler üzerinde 

yapılmıştır. Bu örnekler içlerine özel harçlar enjekte edilerek ve bazı uygulamalar 

yapılarak güçlendirilmiştir. Numerik simülasyon ve deneysel sonuçlar karşılaştırılarak 

güçlendirme tekniklerini anlamak için kritik bilgiler elde edilmiştir. 

Ekinci [49] tarafından 2015 yılında yapılan çalışmada, I. Ulusal Mimarlık Dönemi’ne ait 

beş adet yığma yapının; Çapa Anadolu Öğretmen Lisesi, Gazi İlköğretim Okulu, İstanbul 

Üniversitesi MSB Binası, Sultan Selim Kız Meslek Lisesi ve Gelenbevi Anadolu Lisesi 

yapılarının taşıyıcı sistem malzeme özellikleri belirlenerek sayısal analizleri yapılmıştır. 

Binaların taşıyıcı sistemi olan kâgir elemanların malzeme özelliklerini belirlemek amacı 

ile sahada kayma deneyi; laboratuvar ortamında ise basınç ve birim hacim ağırlık 

deneyleri yapılmıştır. Bu sonuçlar değerlendirildikten sonra sayısal analiz yapılmıştır. 

Yapıların sayısal analizi üç farklı hesap yöntemi ile SAP2000 uygulamasında modal analiz, 

Eşdeğer Deprem Yükü Yöntemi ve yine Eşdeğer Deprem Yükü Yöntemi ile birlikte 

burulma hesapları yapılmıştır. Sayısal hesapların yanı sıra DBYBHY’de yer alan yeni yığma 

yapıların sağlaması gereken yapısal kuralların söz konusu yapılarda sağlanıp 

sağlanmadığı belirlenmiştir. Sultan Selim Kız Meslek Lisesi ve Gazi İlköğretim Okulu 

binalarında yapılan yerinde kayma dayanımı deneylerine göre her bir kat için belirlenen 

ortalama kayma dayanımı indeksi değerlerinde katlar arasında büyük farklılıklar 

bulunmamıştır. Çapa Anadolu Öğretmen Lisesi, Gelenbevi Anadolu Lisesi ve İstanbul 

Üniversitesi MSB yapılarında ise bodrum ve zemin katlarda hesaplanan ortalama kayma 

dayanım indeksi değerlerinin, normal katlardaki ortalama kayma dayanımı indeksi 

değerlerinden farklı oldukları görülmüştür. İstanbul Üniversitesi MSB, Gelenbevi 

Anadolu Lisesi, Çapa Anadolu Öğretmen Lisesi ve Sultan Selim Kız Meslek Lisesi 

binalarının her iki doğrultudaki tüm duvarlarının kesme dayanımının, uygulanan deprem 

etkileri altında oluşan kesme kuvvetlerini karşılamaya yeterli olduğu bulunmuştur. 

Yalnızca Gazi İlköğretim Okulu Binası’nda, yığma binanın tüm katlarında her iki 

doğrultudaki duvarlarının kesme dayanımının, uygulanan deprem etkileri altında oluşan 

kesme kuvvetlerini karşılamadığı hesaplar sonucunda tespit edilmiştir. İncelenen 

yapılardan elde edilen sonuçlara göre, Gazi İlköğretim Okulu dışındaki binalar için 

deneysel olarak elde edilen ortalama kayma dayanım indeksi değerleri, analiz sonucu 

elde edilen ortalama kayma dayanım değerlerinden daha büyük çıkmıştır. Fakat yapıların 
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ortak özelliği olan geniş pencerelere sahip olmaları, yapılan analizlerde bu açıklıkların 

bulundukları yerde hasar mekanizmalarının oluşmasına neden olmaktadır. SAP2000 

uygulaması ile yapılan değerlendirmelerde tüm binalarda bu açıklıkların bulunduğu 

bölgelerde duvar düzleminde gerilme yığılmalarının oluştuğu tespit edilmiştir. 

Çal ve Şahin [50] tarafından 2015 yılında yapılan çalışmada, Ortaköy Büyük Mecidiye 

Camii’nin sayısal modeli oluşturulmuş ve yapısal davranışının değerlendirilmesi amacı ile 

zaman tanım alanında Kocaeli, Landers ve Northridge depremlerinin ivme kayıtları 

kullanılarak dinamik analizler gerçekleştirilmiştir. Analiz sonucunda yapıda oluşan yer 

değiştirme ve gerilme değerleri elde edilmiştir.  

Çal [51] tarafından 2015 yılında yapılan çalışmada, Ortaköy Büyük Mecidiye Camii’nin 

sayısal modeli oluşturulmuştur. Yapısal davranışının değerlendirilmesi amacı ile statik ve 

dinamik analizleri yapılmış ve analiz aşamasından sonra yapının genel davranışı elde 

edilmiştir. Mevcut yükler ve deprem etkisi altında en fazla zorlanan kesit ve bölgeler 

tespit edilmiş ve yapının davranışı genel olarak yorumlanarak zorlanan bölgeler ile ilgili 

değerlendirmelerde bulunulmuştur. 

Tetik [52] tarafından 2015 yılında yapılan çalışmada, İstanbul'da bulunan Şeyh Süleyman 

Mescidi SAP2000 uygulamasında modellenmiştir. Statik ve dinamik yükler altında 

yapının analizi yapılmış ve hasar oluşması beklenen bölgeler tespit edilerek güçlendirme 

tekniklerine göre önlemler tavsiye edilmiştir. 

Hökelekli [53] tarafından 2015 yılında yapılan çalışmada, tarihi yığma yapı olan Manisa 

Hafsa Sultan Camii ve minaresi üzerine çalışılmıştır. Yığma yapıların dinamik davranışı, 

tarihi yapılarda koruma kavramı, tarihi yapıların incelenmesi, yığma yapı malzeme 

özelliklerinin belirlenmesinde kullanılan yöntemler, malzeme modelleme teknikleri, 

yığma yapıların sayısal olarak modellenmesi ve sonlu elemanlar yöntemine dayalı 

dinamik formülasyonlar hakkında bilgiler verilmiştir.  Yapıların dinamik parametrelerinin 

belirlenmesinde kullanılan, deneysel modal analiz yöntemleri, yöntemlerde kullanılan 

test aletleri ve deneysel yöntemlere ait formülasyonlar verilmiştir. Sonlu elemanlar 

analizinde kullanılacak yığma duvar malzeme parametreleri ile laboratuvar çalışmaları 

hakkında bilgiler verilmiştir. Sultan Camii ve minaresinin üç boyutlu sonlu eleman modeli 

oluşturularak, deneysel ve dinamik karakteristikleri tespit edilmiştir. Sultan Camii 

Minaresi iyileştirilmiş sonlu eleman modeli kullanılarak doğrusal ve doğrusal olmayan 
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deprem analizleri yapılmıştır. Teorik ve deneysel yöntemlerle elde edilen doğal 

frekanslar incelendiğinde arasında %10 civarında bir fark olduğu tespit edilmiştir. Doğal 

frekanslar arasındaki farkı giderebilmek için deneysel ölçüm verileri dikkate alınarak 

sayısal model iyileştirilmiştir. Model iyileştirmesi sonucu frekanslar arasındaki fark %1 

civarına düşürülmüştür. Sultan Camii iyileştirilmiş ve iyileştirilmemiş sonlu eleman 

modeli üzerinde zaman tanım alanında doğrusal deprem çözümlemesi yapılmıştır. 

Kültürel değerleri koruma performans seviyesi göreli öteleme sınırının ana kubbe tepe 

noktasında model iyileştirmesinden öncesi 4.5, model iyileştirmesinden ise sonrası 11 

kat aşılmakta olduğu tespit edilmiştir. Basınç gerilmeleri Cami girişi üst kemeri 

bölgesinde duvar gerilme sınır değerlerini 2.1 kat aşmaktadır. Çekme gerilmelerinin Cami 

girişi üst kemeri bölgesinde duvar gerilme sınır değerlerini 15 kat aşmakta olduğu 

belirlenmiştir. Minare küp gövde birleşim bölgesinde doğrusal analizi sonucu elde edilen 

basınç gerilmeleri duvar basınç sınır gerilmesini 13 kat, çekme gerilmeleri duvar çekme 

sınır gerilmesini 140 kat aşmaktadır. Minare küp gövde birleşim bölgesinde doğrusal 

olmayan analiz sonucu elde edilen basınç gerilmeleri, duvar basınç sınır gerilmesini 

aşmamakta, çekme gerilmeleri ise duvar sınır çekme gerilmesini 1.1 kat aşmaktadır. 

Minare küp-gövde birleşim bölgesinde, doğrusal deprem analizi sonucu elde edilen 

çekme gerilmelerinin, doğrusal olmayan deprem analiz sonucu elde edilen çekme 

gerilmelerinden ortalama olarak 130 kat, basınç gerilmelerinin ise ortalama olarak 16 

kat daha büyük olduğu görülmüştür. Genel olarak incelendiğinde minarenin özellikle küp 

gövde birleşim, balkon bölgesinde hasarların oluşacağı beklenmektedir. 

Pantò [54] vd. tarafından 2016 yılında yapılan çalışmada, özgün bir modelleme yaklaşımı 

ile tarihi bir yığma yapının statik ve sismik yüklemeler altındaki doğrusal olmayan 

davranışı incelenmiştir. Pantò tarafından önerilen ayrık modelleme yaklaşımı tüm 

yapının doğrusal olmayan davranışını yakalamayı hedeflemiştir. Yığma yapıların 

düzlemde ve düzlem dışında tepkilerini simüle etmek için ayrık modelleme yaklaşımı 

kullanarak daha önce kısmen çalışılmış bir bazilika kilise (büyük kilise) üzerinde 

çalışılmıştır. Tüm yapı ile elde edilen sonuçlar ve ayrık modelleme yaklaşımı ile elde 

edilen sonuçlar karşılaştırılmıştır. 

Aslan ve Şahin [55] tarafından 2016 yılında yapılan çalışmada, Mimar Sinan’ın 1550 

yılında yapımına başladığı ve 7 senede yapımını bitirdiği Süleymaniye Camii 3 boyutlu 
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olarak SAP2000 uygulamasında modellenmiş ve farklı depremlerin etkisi altında 

davranışı incelenmiştir. Modellemede sonlu elemanlar yöntemi kullanılmış, depremler 

ise geçmişte yaşanan gerçek deprem kayıtları kullanılarak yapıya etki ettirilmiştir. Analiz 

sonucunda yapının deprem etkileri altında yapacağı davranışlar elde edilmiş ve yapının 

depremlerden en çok etkilenen bölgeleri tespit edilmiştir. Sonuçlar neticesinde yapı 

hakkında değerlendirmeler yapılmıştır. 

 Tezin Amacı 

Tarihi yapıların doğal afetler yaşanmadan önce gerekli önlemler alınarak korunması 

gerekir. Söz konusu yapıların malzeme ve geometrik özelliklerinin bilinmesinin yanında, 

uygun modelleme teknikleri kullanılarak yapısal analizlerinin gerçekleştirilmesi ve analiz 

sonuçlarına bağlı olarak gerekli görülen yapıların onarım ve güçlendirilmesinin yapılması 

gerekmektedir.  

Bu çalışma kapsamında Mimar Sinan tarafından yapılan Süleymaniye Camii’nin sonlu 

elemanlar yöntemi kullanarak, Sap2000 programı ile statik ve dinamik analizleri yapılmış, 

yapının kendi ağırlığı altındaki ve deprem yükleri etkisindeki davranışı belirlenmeye 

çalışılmıştır. Bu etkiler altında yapının zayıf ve kuvvetli olduğu yerler tespit edilmiş 

böylece güçlü bir depreme maruz kalmadan önce yapının performansı belirlenmeye 

çalışılmış ve önlem alınması gereken riskli yerlerin tespit edilmesi hedeflenmiştir. 

Ayrıca Camii’nin bulunduğu bölgenin yerel zemin koşullarının yapının sismik 

performansına olan etkisinin incelenmesi ve yaşanmış deprem kayıtlarının oluşturulan 

zemin modeli kullanılarak yapıya etki ettirilmesi amaçlanmıştır. Bununla birlikte farklı 

karakteristik özelliklere sahip deprem kayıtları yapıya etki ettirilerek sismik davranışın 

değerlendirilmesi amaçlanmıştır. 

 Hipotez 

Tarihi yapıların modellenmesinde başta sonlu elemanlar metodu olmak üzere çeşitli 

yöntemler vardır. Yapılan modellemeleri birbirinden ayıran en önemli özellik ise yapının 

bünyesinde bulundurduğu malzeme özelliklerini modele yansıtma biçimidir. Kullanılan 

malzemelerin karakteristik özellikleri deneysel bulgularla yerinde birebir 

belirlenebileceği gibi, diğer yandan bu karakteristik özelliklerde çeşitli idealleştirmelere 
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gidilebilir. Malzeme davranışlarını gerçek bir şekilde yansıtmak daha çok zaman ve 

maliyet gerektireceği gibi ayrıca yapı bünyesinde hasar oluşturma riski de vardır. Tarihi 

yığma yapıların araştırılmasında teorik malzeme karakteristik değerlerini kullanılarak 

gerçek yapının frekansları ile model yapının frekansları karşılaştırılır. Frekanslar uyumlu 

çıktığı takdirde model yapı analiz yapmak amacı ile kullanılabilir.  

Ayrıca yerel zemin koşulları, tarihi yapıların dinamik davranışlarının incelenmesinde göz 

önüne alınmalıdır. İncelenecek olan yapının bulunduğu bölgede yapılan zemin ölçümleri 

kullanılarak, bölgede seçili bir alan zemin modeli oluşturularak, yapı zemin etkileşimi göz 

önüne alınabilir. Bununla beraber, deprem istasyonlarından alınan kayıtlar zemin 

modelinin ana kayasına aktarılarak zemin büyütmesine bağlı yüzey hareketleri 

hesaplanabilir ve incelenecek yapıya özgü deprem kayıtları tespit edilerek deprem 

analizleri yapılabilir. Böylelikle incelenecek olan yapının zemin koşullarına bağlı olarak 

sismik performansı değerlendirilebilir. 
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2.  

BÖLÜM 2 

SÜLEYMANİYE CAMİİ HAKKINDA BİLGİLER 

 Tarihçesi 

Külliyenin1 merkez konumunda yer alan Süleymaniye Camii, 1550 - 1557 yılları arasında, 

Mimar Sinan tarafından Osmanlı padişahı Kanuni Sultan Süleyman adına inşa edilmiştir. 

Osmanlı mimarisinin baş eserlerinden biri olarak kabul edilen Süleymaniye Camii, tarih 

boyunca depreme karşı dayanımı bakımından üstün bir performans göstererek 

günümüze kadar pek çok şiddetli depremi başarı ile atlatmıştır. 

Yaklaşık 70 dönümlük arazide yer alan, cami ve haziredeki2 Kanuni ve Hürrem türbeleri 

dışında, farklı seviyelerde eğitim veren medreseler, bir hadis okulu, bir tıp medresesi, 

ilkokul, hastane, misafirhane, Kuran eğitimi yapılan bir yapı, imaret denilen aş evi, 

kütüphane, hamam, han, Sinan’ın türbesi ve çok sayıda sıra dükkânlar bulunmaktadır. 

Evliya Çelebi buranın, çevredeki yapılar ile birlikte, ”bin kubbe” ile örtülü olduğunu ve üç 

bin kişinin burada hizmet ettiğini yazar. [56] 

Caminin ilk onarımı Sultan IV. Mehmet döneminde 1660 yılında çıkan yangın sonucunda 

yapılmıştır. Minarelerin kurşun külahları değiştirilmiştir. 1760 tarihinde camide ufak 

çapta basit onarımlar yapılmıştır. Yine bu tarihte büyük bir yangın olmuş ve ana kubbe 

zarar görmüştür. Günümüzde devam eden restorasyon çalışmaları sırasında yapılan 

                                                      

1 “Külliye, camii ile birlikte hamam, medrese, mektep, imaret, türbe, kütüphane, aşevi, darüşşifa, 
kervansaray, çarşı, tekke, zaviye binalarından oluşan yapılar topluluğu” [80] 

2 “Hazîre, külliye, cami, mescit, tekke gibi dini yapıların avlularında yer alan etrafı duvar veya parmaklıkla 
çevrili mezarlıklara verilen isim” [80] 
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analizler neticesinde yapının kubbesinin sıva ve boya olarak onarım gördüğü tahmin 

edilmektedir. 1808 tarihinde ise yeniçeri ayaklanması sırasında yapının minareleri zarar 

görmüştür. [57] 

Çeşitli dönemlerde yapılmış bazı ekler dışında yapı kütlesel bütünlüğünü koruyabilmiştir. 

Bu eklerden en önemlisi mihrap aksının sağında, kadınlar mahfilinin ise altında yer alan 

kütüphanedir. Bronz şebekeler ile ana mekândan ayrılan kütüphane Sultan 1.Mahmud 

döneminde 1751-1752 tarihlerinde yapıya eklenmiştir. 1940 yılında ise caminin son 

cemaat yerine ilişkin kararlar alınmıştır. [57] 

 Coğrafi Konumu 

Süleymaniye Camii, Şekil 2.1’de görüldüğü gibi Türkiye’nin İstanbul ili, Fatih İlçesi1, 

Süleymaniye mahallesinde, 97. pafta, 377. ada, 6. parselde yer almaktadır2 [58]. Harita 

üzerinde ise 41°00′58″ kuzey paraleli 28°57′50″ doğu meridyeninde yer alır [59]. 

Cami’nin vaziyet planı Şekil 2.2’de görüldüğü gibidir. 

 

Şekil 2.1 Süleymaniye Camii harita üzerindeki konumu [59] 

                                                      

1 7 Mart 2008’den önce caminin bulunduğu yer Eminönü ilçesi olarak geçmektedir. 

2 Ocak 2007 yılında hazırlanan vaziyet planındaki konum bilgileridir. 
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Şekil 2.2 Süleymaniye Camii vaziyet planı [58] 

 Yapısal ve Mimari Özellikleri 

Süleymaniye Camii her biri yaklaşık 30’ar ton olarak hesaplanan dört fil ayağı üzerine 

kurulmuştur. Ana kubbe ve üst kâgir kabuk yaklaşık 1000 ton ağırlığındaki yükü iki yarım 

kubbeyle ve fil ayaklarıyla temele iletirler. Fil ayaklarının her birinin ise 8 000 ton yükü 

temele ilettiği düşünülmektedir [56]. Bu fil ayaklarının arasında dört ana kemer bulunur. 

“Ana kemerler gergisiz olarak inşa edilmiştir. Ancak, Süleymaniye’nin orta iç mekânını 

örten strüktürde, birincil yarım kubbeler ile ikincil yarım kubbeler arasındaki 

açıklıklardaki daha küçük olan kemerlerde gergi kullanılmıştır.” [57] 

Fil ayakları ve ana kemerlerin üzerinde caminin ana kubbesi yer alır. Caminin kubbesi 

tepede bulunan alem kısmı hariç 50,5 metre yüksekliğinde, çapı ise 27,5 metredir. Kubbe 

kasnağında 32 pencere bulunmaktadır. İki adet yarım kubbe ana kubbeyi yanlardan 

desteklemektedir. Bu yarım kubbeler de daha küçük ikişer adet kubbeler ile 

desteklenmektedir. Yarım kubbelerin olmadığı taraflarda ise beşer adet çeşitli 

boyutlarda kubbeler mevcuttur. Bunun dışında avluda yirmi sekiz adet küçük kubbe 

vardır [58].  
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Şekil 2.3 Süleymaniye Camii [60] 

Camide dört adet minare vardır. Bunun nedeni Kanuni Sultan Süleyman’ın İstanbul’un 

fethinden sonraki 4. Osmanlı padişahı olmasıdır. Bu minareler avlunun dört köşesinde 

konumlanmıştır. Avlunun cami ile bitişik kısmındaki minareler (doğu ve güney 

minareleri) 76 metre yüksekliğinde olup üçer adet şerefesi vardır. Ana yapıdan uzakta ve 

diğerlerine göre daha kısa olan minareler (kuzey ve batı minareleri) 55,5 metre 

yüksekliğinde olup ikişer adet şerefesi vardır. Bu dört minaredeki on şerefinin de Kanuni 

Sultan Süleyman’ın Osmanlının onuncu padişahı olduğunu simgelemiştir (Şekil 2.3) [58]. 

Temel zemini açısından bakıldığında, 1970’li yıllarda yapılan çalışmalar sonucuna göre 

Süleymaniye Camii’nin şist ve grovaktan oluşan bir ana kaya üzerine oturduğu 

saptanmıştır. Cami zemininin genel olarak İstanbul’unun pek çok noktasına göre yüksek 

dayanıma sahip olduğu söylenebilir [61]. 

Süleymaniye Külliyesi'nin ana yapısı olan Süleymaniye Camii Kâbe eksen doğrultusunda 

avlu ile birlikte 114,88 m, avlu hariç 64,68 m’dir. Buna dik doğrultuda ise 69,23 m'dir. 
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Cami 3997,5 m2, avlu ise 3049 m2 olmak üzere toplam 7046,5 m2’lik alan üzerine 

kuruludur. Cami dış hatlarının toplam çevresi 339,5 m’dir. Avlunun dış hatlarının toplam 

çevresi ise 230,4 m’dir. Bitişik haldeki toplam çevre 444,9 m’dir. Cami, Kâbe eksenine 

göre nerdeyse tamamen simetrik olup buna dik eksende simetriğe yakındır [58]. Yapının 

zemin planı rölöveleri Şekil 2.4 ve Şekil 2.5’te, kuzey doğu rölövesi ise Şekil 2.6’da 

gösterilmektedir. 

 

Şekil 2.4 T.C. Başbakanlık Vakıflar Genel Müdürlüğüne ait 2007 yılında hazırlanmış 
AutoCAD rölövesindeki zemin planının sadeleştirilmiş hali [58] 

 

Şekil 2.5 Yüksek Mimar Ali Saim ÜLGEN’nin 1940 yılında çizdiği rölövelerdeki zemin 
planı [62] 
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Şekil 2.6 Süleymaniye Camii kuzeydoğu cephesi rölövesi [58] 

 Kubbenin Restorasyonu 

Vakıflar Genel Müdürlüğü tarafından en son 1960’lı yıllarda restore edilen Süleymaniye 

Camii, ondan sonraki dönemlerde mahalli imkânlarla her hangi bir projeye bağlı olmadan 

onarılmış ancak yapılan müdahalelerde eski eser kriterlerine dikkat edilmediği için eser 

bünyesindeki özgün detaylara zarar verilmiştir. Yapılan bu ilk tespitler sonucunda 

hazırlanan rölöve1, restitüsyon2 ve restorasyon3 projesi, detayları ve raporu ile İstanbul 

IV Numaralı Kültür ve Tabiat Varlıklarını Koruma Kurulu’ndan 14.02.2007 tarih ve 1047 

sayılı kurul kararı ile onarıma yönelik karar alınmıştır. Koruma kurulu kararına dayalı 

olarak da 15.10.2007 tarihinde yer teslimi yapılarak, Süleymaniye Camii restorasyon 

çalışmalarına başlanmıştır [56]. 

                                                      

1 Rölöve, yapının şimdiki halinin projesine denir. 

2 Restitüsyon, yapının geçmişteki halinin projesine denir. 

3 Restorasyon, yapının yapılmak istenen projesine denir. 
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Yapının ana kaya üzerine yapılması sayesinde cami zemini yüksek bir dayanım göstermiş 

ve zeminde sorun tespit edilmemiştir. Restorasyon çalışmalarında yapılan incelemelerde 

kubbenin geneline yayılmış olan çatlaklar tespit edilmiştir (Şekil 2.7) [61]. 

 

Şekil 2.7 Cami ana kubbesi kesitleri üzerindeki çatlakların gösterimi [61] 

Kubbe 2mm kalınlığında kurşun ile kaplı olup, kurşun altında yaklaşık olarak 7 cm 

kalınlığında bir dolgu tabakası, tuğla kubbe cidarı ve içte 5 cm kalınlığında bir sıva 

tabakası bulunmaktadır. Kubbe örgüsü tuğla ile oluşturulmuş olup tuğla kalınlığı 4-6 cm 

derz kalınlığı 4-6 cm arasında değişmektedir. Çatlaklar pencere üst kotundan başlayarak 

kubbenin çekme bölgesi boyunca devam etmektedir. En büyük çatlak genişliklerinin 

yaklaşık olarak 10 mm - 20 mm mertebesinde olduğu tespit edilmiştir. Çatlakların büyük 

bir bölümü SEBU’lar1 nedeniyle zayıflamış olan bölgelerden geçmekteydi. Kubbe örtüsü 

kaldırılarak yapılan kontrollerde kubbe dışında da kılcal çatlakların olduğu tespit 

edilmiştir. Kubbe içinde belirlenen çatlakların derinlikleri 5 cm - 45 cm arasında 

değişmektedir. Kalınlığı ortalama 95 cm olan tuğla yığma kâgir kubbede izlenen bu tür 

çatlak oluşumları yapısal karakterde çatlaklardır. Kâgir kubbelerde kabuk davranışı 

gereği düşey yükler altında çekme bölgesinde, kubbe eteğinden itibaren belli bir kota 

kadar, radyal çatlak oluşumu beklenebilir. Cami ana kubbesinde de bu davranış tipik 

olarak gözlenmiştir. Bunun dışında deprem yüklemesi gibi yatay yükler etkisinde ise 

çatlakların, kubbenin orta bölgelerinde yoğunlaşması beklenmektedir. Kubbedeki çatlak 

dağılımı incelendiğinde hasarın belli bir bölgede yoğunlaşmayıp, kubbenin geneline 

yayıldığı gözlenmiş olup, çatlak oluşumunun düşey ve zaman içinde meydana gelmiş 

önemli deprem etkilerinden kaynaklandığı düşünülmektedir [61]. 

                                                      

1 Sebu, hem caminin akustiğini sağlayan hem de kubbenin statik açıdan yükünü hafifleten boşluklardır. 
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Yerinde yapılan incelemelerden kubbe eteğinde ve ortasında saptanan çemberlerde 

herhangi bir bozulma tespit edilmemiştir. Kubbe ile ilgili hesaplardan demir 

çemberlerdeki gerilme düzeylerinin değerlendirilmesi sonucunda bu elemanların 

olabilecek bir depremde kubbenin ağır hasar almasını engelleyici nitelikte olduğu 

kanaatine varılmıştır. Restorasyon çalışmaları sırasında yapılan hesaplamalara göre 

kubbede oluşan basınç gerilmeleri emniyet değerlerin oldukça altında kalmaktadır. Bu 

nedenlerle kubbedeki mevcut çatlakların onarılması, korozyona1 uğramış gergilerin 

temizlenmesi dışında bir güçlendirmenin yapılmasına gerek duyulmamıştır [61]. 

 

Şekil 2.8 Kılcal Çatlaklar İçin Onarım Detayı [61] 

Kubbede belirlenen çatlakların onarımı için çatlak genişliğine bağlı olarak iki farklı onarım 

yapılmıştır. Çatlakların kılcal olması durumunda (çatlak genişliği 1cm’den küçük) yapının 

mevcut harcına benzer özelliklerdeki malzemenin 1-2 bar gibi düşük basınç altında 

enjeksiyonuyla2 onarımı yapılmıştır (Şekil 2.8). Çatlakların orta genişlikte olması 

durumunda ise (çatlak genişliği 4 cm’ye kadar) çatlağın paslanmaz çelik dikiş 

elemanlarıyla dikildikten sonra yapının mevcut harcına benzer özelliklerdeki 

malzemenin 1-2 bar gibi düşük basınç altında enjeksiyonuyla onarımı yapılmıştır [61]. 

                                                      

1 Korozyon, metal veya metal alaşımlarının oksitlenme veya diğer kimyasal etkilerle aşınma durumudur. 

2 Enjeksiyon, kanal veya boşluk içine genellikle enjektör aracılığı ile sıvı verme işlemidir. 

Bu noktadan çıkana 
kadar devam edilir 

Enjeksiyon harcı ile 
doldurulacak 

Bağlayıcı en alt noktadan 
enjekte edilecek 
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3.  

BÖLÜM 3 

KARMAŞIK YAPILARIN MODELLENMESİ 

 Nümerik Modelleme Teknikleri 

Genel olarak yığma yapıların nümerik yaklaşımlarında yığma birim ve harç ayrı ayrı 

modellenerek mikro modelleme, basitleştirilmiş mikro modelleme ya da bütün 

malzemeler homojenize edilerek makro modelleme yapılabilir (Şekil 3.1, Şekil 3.2, Şekil 

3.3). Basitlik ve gerçeğe yakınlık bakımından belirtilen modelleme yöntemlerinden birisi 

tercih edilebilir.  Genelde mikro modelleme yığma duvarlar veya yapının belirli bir 

bölümünün modellenmesinde, makro modelleme ise tüm yapı sisteminin 

modellenmesinde kullanılır. 

 

Şekil 3.1 Mikro modelleme [63] 

Mikro modellemede, yığma birim ve harcın malzeme özellikleri ayrı ayrı değerlendirilir. 

Bu modelleme tekniği genellikle yapı sisteminin bir bölümünün çözümü için 

kullanılmaktadır. Tam yapılmış bir mikro model yapının bütün sorunlarını içermelidir. 

Birleşim yerlerindeki kaymalar, birimlerdeki çatlaklar ve kırılmalar gibi birçok sorun 

dikkate alınarak modellenmelidir. 

Tuğla (Yığma Birim) Harç 

Tuğla/Harç 

Ayırma Yüzeyi 
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Şekil 3.2 Basitleştirilmiş mikro modelleme [63] 

Basitleştirilmiş mikro modellemede, yığma birimler harç tabakasının kalınlığının yarısı 

kadar genişletilir. Harç tabakası ihmal edilir ve yığma birimler birbirlerinden ara yüzey 

çizgileriyle ayrılır. Sistemde meydana gelmesi muhtemel çatlakların bu ara yüzey 

çizgilerinde meydana geleceği kabul edilir. 

Makro modelleme ise, yığma birim, harç vs. arasında ayrım yapmaksızın, yapı elemanını 

kompozit1 olarak kabul eder ve bu malzemelerin ortak özelliğini yansıtarak eşdeğer bir 

malzeme modeli meydana gelir. Bu yöntem, büyük yapı sistemlerin modellenmesinde 

genelde tercih edilmektedir. Hem modellemenin kolaylaşarak daha kısa sürede 

tamamlanmasını hem de analiz kısmında daha hızlı sonuçlar elde edilmesini 

sağlamaktadır [41], [64]. Şekil 3.4’te Bursa Ulu Camii’nin makro modelleme yaklaşımı ile 

oluşturulmuş 3 boyutlu modeli gösterilmiştir. 

 

Şekil 3.3 Makro modelleme [63] 

                                                      

1 Birbirinden ayrı iki veya daha fazla malzemenin bir araya getirilmesi ile imal edilen malzeme türü. 

Bütün Birim 

Yığma Birim Ayırma Yüzeyi 
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Şekil 3.4 Bursa Ulu Camii makro model örneği [65] 

 Karmaşık Yapıların Modellenmesi 

Bu bölüm inşaat mühendisleri tarafından yaygın olarak kullanılan AutoCAD ve Sap2000 

programları kullanılarak karmaşık geometriye sahip tarihi yığma yapıların 3 boyutlu 

makro modellemelerinin oluşturulması için bir yaklaşım sunulmaktadır. Buna göre 

AutoCAD ilse Sap2000 etkileşimli olarak kullanılarak AutoCAD’den Sap2000’e nesnelerin 

aktarılması sağlanacaktır. 

Öncelikle Sap2000 programına AutoCAD rölöve dosyaları üzerinden aktarılmak istenilen 

nesneler belirlenirler. Ardından nesnelerin türünün Sap2000 için uygunluğu kontrol 

edilir. Bunun için AutoCAD üzerinden “PROPERTIES (Kısa yol: MO)” komutu çalıştırılarak 

gerekli kontroller yapılabilir. Açılan pencere seçilen nesnelerin özelliklerini gösterecektir. 

Pencerenin en üst kısmında (Şekil 3.5) nesnenin türü yazılıdır.  Aktarılmak istenilen 

nesneler ile Sap2000 programının kabul ettiği nesne türlerinin aynı olup olmadığı 

kontrolü yapılır. Çizelge 3.1’de gösterildiği şekilde nesnelerin türü uyuşmuyorsa 

AutoCAD üzerindeki nesneler uygun türe çevrilebilir. Aksi takdirde rölöve üzerinde ana 

hatlar çizilip Sap2000’e aktarılır ve bu çizgiler yardımı ile Sap2000’de modelleme yapılır. 

Ardından yardımcı çizgilerin işlevi bittiği için Sap2000 modelinden silinirler. 
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Şekil 3.5 AutoCAD uygulamasındaki PROPERTIES penceresi [66] 

 AutoCAD Üzerinden Sap2000’e Nesne Aktarma  

Bütün nesne türleri için katman oluşturmak daha düzenli ve daha kolay bir çalışma alanı 

sağlayacaktır. Katman oluşturmak için “LAYER (Kısa yol: LA)” komutu ile katman 

penceresi açılır. “NEW LAYER (Kısa yol: ALT+L)” butonu tıklanarak yeni katman 

oluşturulur. 

Çizelge 3.1 AutoCAD’den Sap2000’e aktarılabilen nesneler [67] 

 DXF Nesnesi Sap2000 Nesnesi 

1 Point Joint 1 

2 Line Frame 2 

3 Point Link (Tek Noktalı) 

4 Line Link (Çift Noktalı) 

5 3D Face Shell 3 

6 Polygon Mesh Solid 4 

                                                      

1 Türkçede birleşme yeri, eklem yeri gibi anlamlara gelir. Sap2000 programında noktaları temsil eder. 

2 Türkçede çerçeve anlamına gelir. Sap2000 programında çizgi şeklindeki çubuk elemanları temsil eder. 

3 Türkçede kabuk anlamına gelir. Sap2000 programında AREA adıyla da geçer. İki boyutlu içi dolu 
geometrik şekilleri temsil eder. Genelde üçgen veya dörtgen şeklinde kullanılırlar. 

4 Türkçede katı anlamına gelir. Sap2000 programında içi dolu üç boyutlu geometrik şekilleri temsil eder. 
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3.3.1 Nokta Nesneler 

Nokta nesnelerin (joint), köşe ve uç noktaları dışında özellikle eklenmek istenilen bir 

nokta yok ise tanımlanmasına gerek yoktur. Sap2000 her nesnenin köşe ve uçlarında 

otomatik olarak oluşturacaktır. El ile düğüm noktası eklenmek istenir ise AutoCAD 

üzerinden “POINT (Kısa yol: PO)” komutu kullanılarak düğüm noktası oluşturulabilir. Eğer 

Sap2000 üzerinden düğüm noktası oluşturulmak istenir ise de “Üst Menü > Draw > 

Special JOINT” yolu kullanılarak düğüm noktası oluşturulabilir. 

3.3.2 Çubuk Nesneler 

Çubuk nesneler (frame), kolon ve kiriş gibi nesneleri temsil etmek için kullanılırlar. 

AutoCAD üzerinden “LINE (Kısa yol: L)” komutu ile oluşturulurlar. AutoCAD rölöve 

dosyası üzerinde hali hazırda çizilmiş olan çizgiler gerekli düzenlemeler yapıldıktan sonra 

Sap2000’e aktarılabilir. Eğer çizgiler AutoCAD’de POLYLINE olarak çizilmiş ise “EXPLODE 

(Kısa yol: X)” komutu ile LINE olarak parçalara ayrılabilir ve aktarılabilir hale 

getirilebilirler. 

3.3.3 Kabuk Nesneler 

Kabuk nesneler (shell), genelde yapının döşeme, duvar gibi kısımlarını simüle etmek için 

kullanılırlar (Şekil 3.6). İki boyutlu olarak çizilirler. Üçüncü boyut olan genişlik değeri 

Sap2000 üzerinden “Üst Menü > Define > Section Properties > Area Sections > 

Modify/Show Section > Thickness” yolu kullanılarak ayarlanır. 

 

 

Şekil 3.6 Gerçek yapının kabuk olarak çizilmesi [68] 

Ortalama Yüzey 
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AutoCAD de ki 3D FACE nesneleri Sap2000’e kabuk nesne olarak aktarılırlar. AutoCAD 

uygulamasında 3D FACE elde etmenin çeşitli yolları vardır. “3DFACE” komutu ile tek tek 

yüzeyler çizilebilir. Kolay çizilebilen yüzeyler dışında bu şekilde çizmek zor olacaktır. 

Başka bir yöntem de aktarılmak istenilen yüzeyin etrafını “POLYLINE (Kısa yol: PL)” 

komutu ile çizmektir. POLYLINE çizgisi kapalı olmak zorundadır. Bu nedenle son çizgi 

“CLOSE (Kısa yol: C)” komutu ile çizilmelidir. Ayrıca PROPERTIES penceresinde Misc 

sekmesinin içinde bulunan Closed yazısının yanındaki NO seçeneği YES olarak 

değiştirilerek de POLYLINE kapatılabilir. Kapalı POLYLINE seçilip “CONVTOMESH 

(Alternatif komut: MESHSMOOTH)” komutu girilir. Açılan pencereden Create Mesh 

seçeneği seçilerek mesh nesnesine çevrilir. Mesh nesnesi seçilerek PROPERTIES 

penceresi açılır. Smoothness yazısının yanında Level’ler mevcuttur. Level’leri artırmak 

elde edilecek 3D FACE sayısını arttırır. Eğer tek parça halinde 3D FACE isteniyor ise NONE 

seçilmelidir. Buna rağmen birden fazla 3D FACE oluşabilir. Bunun nedeni ise mesh 

yapmanın nesneyi dörtgen ve üçgenlere bölmek demek olmasıdır. Çizilen POLYLINE 

dörtten fazla kenara sahip ise birden fazla 3D FACE oluşacaktır. Mesh nesnesi “EXPLODE 

(Kısa yol: X)” komutu ile 3D FACE parçalarına bölünür. 

Bir diğer yöntem ise POLYLINE nesnelerini “REGION (Kısa yol: REG)” komutu ile bölgeye 

çevirmektir. Bölge haline gelen nesneler birbirinden çıkartılabilir hale gelirler (Örneğin 

duvardaki pencere boşluğu gibi). “SUBTRACT” komutu ile önce kalması istenilen bölge 

seçilir ardından çıkartılması istenilen bölge seçilerek bölgeler arası çıkarma işlemi 

uygulanır. Kalan bölge “CONVTOMESH (Alternatif komut: MESHSMOOTH)” komutu ile 

mesh haline getirilir. PROPERTIES penceresindeki Smoothness ifadesi NONE yapılarak 

oluşan bozulma ortadan kaldırılabilir. Nesnenin dış hatları aynı kalacaktır ama iç kısımlar 

dörtgen ve üçgenlere bölünmüş olacaktır. Mesh nesnesi “EXPLODE (Kısa yol: X)” komutu 

ile 3D FACE parçalarına bölünür. 

3.3.4 Katı Nesneler 

Sap2000’de katı nesneler (solid) 3 boyutlu bütün nesneleri modellemede kullanılabilir. 

AutoCAD uygulaması ile POLYGON MESH oluşturmak için “3DMESH” komutu kullanılır. 

AutoCAD ile çizilen katı nesneler Sap2000 programına aktarılamamaktadır. POLYGON 

MESH çizimi AutoCAD ile zor olduğundan bu yöntem tavsiye edilmemektedir. 
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 Süleymaniye Camii’nin Modellenmesi 

3.4.1 AutoCAD ile Şablon Oluşturulması 

AutoCAD projesi üzerinden cephelerin ve zemin planların ana hatları POLYLINE ile çizilir 

(Şekil 3.7). Karmaşıklığı azaltmak için yeni bir AutoCAD dosyası açılarak yeni projenin 

içine bu çizgiler kopyalanabilir. “3DROTATE” komutu ile bütün cepheler ve zemin planı 

kendi eksenine 3 boyutlu olarak çevrilip ve zemin planı üzerine yerleştirilirler (Şekil 3.8). 

Bütün cepheler ve zeminin ayrı ayrı katmanlara tanımlanması daha elverişli bir çalışma 

ortamı sağlayacaktır. Sap2000’e aktarılmak istenilen kısımlar AutoCAD uygulamasında 

önce “EXPLODE (Kısa yol: X)” komutu ile POLYLINE nesnelerden LINE nesnelere 

dönüştürülmelidir. AutoCAD projesi DXF formatında kayıt yapılarak Sap2000 

uygulamasına geçilebilir. 

  

Şekil 3.7 Güneydoğu cephesinin dış hatlarının AutoCAD uygulaması ile çizilmesi [58] 

3.4.2 Sap2000 ile Model Oluşturulması 

Sap2000 üzerinden “Üst Menü > File > Import > AutoCAD .dxf File” seçeneği ile AutoCAD 

dosyaları içeri aktarılabilir. Karmaşıklığı önlemek için cephelerin birer birer aktarılması 

daha iyi olacaktır. Global Z ekseni AutoCAD projesi üzerinden 3DROTATE yapılarak 

ayarlandığı için Z seçeneği seçilmelidir. AutoCAD projesinde çizimlerin hangi birim ile 

çizildiği önemlidir. Bu aşamada Süleymaniye Camii’nin AutoCAD projesinde metre ile 

çizim yapıldığı için içeri aktarmalar aynı şekilde metre seçilerek yapılmıştır. Son olarak 
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açılan pencerede aktarılmak istenilen nesneler Çizelge 3.1’deki şekilde eşleştirilerek 

aktarım işlemi tamamlanır (Ayrıca bknz: Şekil 3.14). 

Süleymaniye Camii projesinde modellemenin tamamı Sap2000 üzerinden yapılmıştır. 

Modellemeye yardımcı olması için sadece ana hatlar AutoCAD uygulaması üzerinden 

çizilmiş ve Sap2000’e yardımcı çizgiler olarak kullanılmak amacı ile aktarılmışlardır (Şekil 

3.9). Başka projelerde, proje elverişli ise daha fazla kısım AutoCAD üzerinden modellenip 

aktarılabilir. Eğer aktarma işlemi sonucu eksik veya hatalı bir aktarım olduysa Çizelge 

3.1’de verilen AutoCAD nesnelerinin doğru şekilde ayarlanmış olduğu kontrol 

edilmelidir. 

 

Şekil 3.8 Örnek zemin planı ve cephelerin ana hatlarının çizimi 

Ana hatlar yardımıyla kabuk nesneler el ile hatların içine çizilmelidir (Şekil 3.10). Burada 

dikkat edilmesi gereken olabildiğince şekil ile uyumlu bir biçimde kabukları parça parça 

ve birbiri ile de uyumlu şekilde çizmektir. Amaç en iyi mesh şeklini elde edebilmektir. 

Uyumsuz ve zor yerleri düz kabul edip kabuklar çizilmeye devam edilebilir. Zor yerlerde 

mesh işleminden sonra el ile düzeltmeler yapılmalıdır. Bütün cephenin kabukları 

çizildikten sonra kabukların hepsi seçilerek “Üst Menü > Edit > Edit Areas > Divide Areas” 

seçeneğinden istenilen mesh ayarları yapılmalıdır. Süleymaniye Camii projesinde yapı 

çok büyük olduğundan 1,5 metrelik mesh boyutları tercih edilmiştir. Bunun için açılan 
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mesh penceresinde “Divide Area into Objects of This Maximum Size” seçeneği 

seçilmelidir. “Along Edge from POINT 1 to 2” yatay mesh uzunluğu, “Along Edge from 

POINT 1 to 3” dikey mesh uzunluğudur. Bu projede ikisine de 1,5 metre uzunluk değeri 

girilmiştir. Seçilen alanların hepsi 1,5 m. x 1,5 m. maksimum uzunluklarda olan kabuklara 

bölünmüştür. Bu işlemden sonra birleşmeyen noktalar tespit edilip düzeltilmelidir (Şekil 

3.11 ve Şekil 3.12). Düz geçilen yerlerde ise silinmesi gereken yerler silinir. 

 

Şekil 3.9 Sap2000’e çubuk eleman olarak aktarılan yardımcı çizgiler 

Silinen yerlerin etrafı el ile çizilmelidir. Bunun için “Üst Menü > Draw > Draw Poly Area” 

seçeneği seçilir. Burada dikkat edilmesi gereken el ile çizilen kabukların saat yönünün 

tersine ve en fazla 4 kenarlı olacak şekilde çizilmesidir. Bunun nedeni meshlenmiş 

nesnelerin üçgen ve dörtgenlerden oluşmasıdır. Çizim yönü ise çizilen kabukların hangi 

tarafının çizildiğini belirler. Eğer çizilen kabuk diğer kabuklardan farklı renkte görünüyor 

ise ilk önce “Üst Menü > View > Refresh View (Kısa yol: Ctrl+Shift+V)” seçeneği ile ekran 

görüntüsünü yenilemek denenmelidir. Eğer halen çizilen kabuk diğer kabuklardan farklı 

renkte görünüyor ise o zaman çizilen kabuğun görünen yüzeyi diğer kabukların görünen 

yüzeyinin ters tarafıdır. Bu durumda kabuk çizimleri önceki çizim yönünün tersi yönünde 

(saat yönünde) yapılabilir. Çizilen kabukların bütün yüzey boyunca aynı tarafa bakması 

önemlidir. Dikkat edilmediği takdirde kabuklar, EXTRUDE1 edilirken katı nesnelere 

çevirmede sorun yaşanılabilir. 

                                                      

1 Extrude, iki boyutlu bir nesneyi yüzeyi doğrultusunda genişleterek üç boyutlu nesne haline getirmektir. 
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Şekil 3.10 Güneydoğu cephesi sağ kısmın yardımcı çizgiler aracılığı ile çizilmeden önceki 
ve sonraki hali 

“Üst Menü > Edit > Extrude > Extrude Areas to Solids” seçeneği ile kabuklara kalınlık 

verilerek katı nesnelere çevrilebilirler. “+3 Dir Thickness” kabukların ön tarafına doğru 

kalınlık vererek katı nesnelere çevirir. “-3 Dir Thickness” ise kabukların arka yüzeyine 

doğru kalınlık verir. Çizilen bütün kabukların aynı yüzeye doğru bakmalarının önemi bu 

noktada çıkmaktadır. Tek taraflı EXTRUDE yapılmak istenirse öteki tarafa 0 yazılması 

yeterlidir. Thickness kısmına toplam genişletilmek istenilen değer yazılır. Number kısmı 

ise toplam genişlik miktarının kaça bölünerek katı nesneye çevrileceğini ifade eder. Yani 

genişlik ekseninde katı nesne parçalara bölünerek oluşturulur. Bu da bir biri ile uyumlu 

mesh yapmak için önemli bir seçenektir. 

Tüm cephe boyunca farklı kalınlıklarda olan yerler olabilir. Bu gibi durumlarda mesh 

kalınlıklarını olabildiğince birbirine denk getirmek gereklidir. Daha kalın olan yüzeyler 

için kabuklar katı nesneye çevrilmeden önce “Üst Menü > Edit > Move (Kısa yol: 

CTRL+M)” ile diğer kabuklardan daha ileri veya geri taşınarak bu kabuklara çift taraflı 

EXTRUDE uygulanabilir (Şekil 3.13). Böylece oluşan katı nesneler daha düzgün yerleşecek 

ve sonuçlar daha gerçekçi çıkacaktır. 
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Şekil 3.11 Meshlemeden sonraki sorunlu yerlerin tespiti 

Bütün proje için aynı prosedür tekrarlanır. Modelin üstü kapatılmadan önce içinin 

yapılması ilerleyen safhalarda zorluk yaşamamak için önemlidir. Bu noktadan sonra 

modelleme daha da karmaşıklaşacağı için yapılacak bütün içeri aktarma işlemlerini 

modelden uzakta bir yere aktarmak ya da aktarmadan hemen sonra “Üst Menü > Edit > 

Move (Kısa yol: CTRL+M)” ile modelden uzağa taşımak kolaylık sağlar. Aktarılan yapının 

ana hatlarını temsil eden yardımcı çizgiler aynı prosedür ile önce kabuk nesnelere sonra 

katı nesnelere çevrilir ve “Üst Menü > Edit > Move (Kısa yol: CTRL+M)” ile modeldeki 

yerine yerleştirilir. 

 

Şekil 3.12 Meshten sonra sorunları düzeltilmiş kabuklar 
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Taşıma işlemi yapılırken model üzerindeki birleşim yapılacak noktanın X, Y, Z 

koordinatları ile taşınacak parçanın birleşim noktasının X, Y, Z koordinatları bilinmelidir. 

Sap2000 programının sağ alt köşesinde farenin koordinatları gözükmektedir. Bu şekilde 

koordinatlar öğrenilebilir. Taşıma işlemi başlatıldığında çıkan pencerede ilk önce model 

üzerindeki birleşim noktasının koordinatı yazılır eksi (-) işareti konularak taşınacak 

parçanın birleşim noktasının koordinatı yazılır ve OK seçeneği seçilerek istenilen 

koordinatlara taşıma işlemi gerçekleştirilir. 

 

Şekil 3.13 Kabukların EXTRUDE edilerek katı nesneye çevrilmesi 

Bu şekilde zor parçalar modelden uzakta modellenerek gerekli yerlere taşınabilir. Model 

üzerinde yapılabilecek modellemeler ise üzerinde yapılır. Kubbeler “Üst Menü > Edit > 

Add to Model From Template” seçeneği ile Sap2000’nin kendi hazır kubbe şablonu ile 

çizilebilir. Yarım kubbe yapmak için tam kubbe, modelden uzakta bir yere şablon ile çizilir 

ve yarısı silinir. Gerekli yere taşınarak birleşim noktaları birleştirilir. Birleşmeyen noktalar 

“Üst Menü > Draw > Set Reshape Element Mode” seçeneği ile tek tek noktalar taşınarak 

birleştirilebilir. Modellemede takip edilecek yok  Şekil 3.14’te verilen akış diyagramında 

özetlenmiştir. Bu algoritma ile Süleymaniye Camii’nin 3 boyutlu modeli tam ölçekli 

olarak Şekil 3.15’de görüldüğü gibi oluşturulmuştur. 
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 Modellemede Kolaylık Sağlayacak Öneriler 

Modelleme sırasında “Üst Menü > View > Set 2D View” seçeneği çok kullanışlıdır. 

Modelin istenilen kesitlerine bakabilmeyi ve 2D olarak modellemeyi sağlar. 

Modelleme yaparken modelin her bir parçasına bir sektör oluşturulması ileriki 

aşamalarda kolaylık sağlayacaktır. Bunun için “Üst Menü > Define > Section Properties > 

Area Section/Solid Properties” seçeneği ile sektörler oluşturulabilir. Seçilen nesnelere 

“Üst Menü > Assing > Area > Sections” veya “Üst Menü > Assing > Solid > Properties” 

seçenekleri ile sektörler atanılabilir. “Üst Menü > Select > Select > Properties > Area 

Sections/Solid Properties” seçeneği ile istenilen sektörün tamamı kolaylıkla seçilebilir. 

Aynı şekilde seçili nesnelerden “Üst Menü > Select > deselect > Properties > Area 

Sections/Solid Properties” seçeneği ile istenilen nesneler seçimden çıkartılabilir. 

“Üst Menü > View > Show Selection Only (Kısa yol: Ctrl+Shift+J)” seçeneği ile sadece 

seçilen yerler görünür hale getirilebilir. Bu hem yavaş bilgisayarlarda rahatlama sağlar 

hem de modelleme sırasında görülmesi zor yerlerin daha rahat görünebilmesi ve 

modellenebilmesini sağlar. “Üst Menü > View > Invert View Selection” görünür nesneleri 

görünmez, görünmez haldeki nesneleri ise görünür hale getirir. “Üst Menü > View > 

Show All” seçeneği ile her şey yeniden görünür hale getirilebilir. 

Sürekli kullanılan kesit görüntüleri için “Üst Menü > Define > Coordinate Systems/Grids 

(Alternatif yol: Sağ Tık > Edit Grid Data)” seçilerek açılan pencereden global koordinat 

sistemi seçilip Modify/Show System seçeneği seçilir. İstenilen koordinatlar açılan 

penceredeki tablolara girilir. Örneğin 10 metre yüksekliğindeki yatay kesit önemli bir 

kesit ise Z Grid Data tablosuna 10 değeri girilmelidir. Programın üst kısmında bulunan 

kısa yol butonlardan XY şeklinde olan simge tıklandığı takdirde XY kesiti ekrana gelir. Bu 

simgenin hemen sağ tarafında yukarı ve aşağı ok şeklinde olan simgeler vardır. Bunlar 

tıklanarak Z Grid Data kısmında yazan Z değerlerindeki XY kesitleri yani yatay kesitler 

ekrana gelirler. Bu şekilde kolaylıkla global koordinat sisteminde değeri girilmiş kesitler 

arasında geçiş yapılabilir. 

“Üst Menü > Draw > Snap to > …” seçeneği ile modelin çizimleri yapılırken modelin 

önemli noktalarına tutunma özelliği açılıp kapatılabilir. Bu özellik sayesinde modelleme 

sırasında uç noktalar, orta noktalar, kesişme noktaları gibi yerlere tutunma sağlanabilir. 
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Bu şekilde model parçalarının birbiri ile bağlantısı konusunda daha güvenilir sonuçlar 

alınabilir. 

Modelleme sırasında yardımcı olması amacı ile kullanılan yardımcı çizgiler (yani çubuk 

nesneler) vb. nesneler var ise model bittikten sonra işe yaramaz hale gelirler. “Üst Menü 

> Select > Select > Properties > Frame Section” seçeneği ile bütün çubuk nesneler seçilip 

silinebilirler. Model bitmeden hemen silinmemesi geriye dönük düzeltmelerde işe 

yarayabilir. Model bittikten sonra bütün gereksiz kabuk nesneler, yardımcı çizgiler vb. 

yardımcı nesneler silinir. Aksi takdirde analiz sonuçlarını direk olarak etkileyeceklerdir. 

Model bittikten sonra analiz işlemlerine başlandığı zaman “Üst Menü > Analyze > Set 

Analysis Options > Solver Options” seçeneği ile açılan pencerede ayarları basit bir analiz 

üzerinde deneyerek hangisinin bilgisayar ve model için en uygun olduğu bulunur ise 

gerçek model üzerinde yapılacak olan analiz işlemleri daha hızlı yapılabilir. 

“Üst Menü > Options > Graphics Mode > DirectX” seçeneği ile bilgisayarın ekran kartı 

kullanılır. Programdan gözle görülür performans artışı yaşanabilir ama modelleme 

yaparken bazı küçük zorluklar çıkartabilir. 

Bütün kabuk ve katı nesnelerin köşe noktaları ile birbirine bağlı olması daha gerçekçi 

sonuçlar alınmasını sağlar. Modelleme sırasında bazen bu bağlantılar yapılamayabilir. Bu 

gibi durumlarda “Üst Menü > Assing > Area/Solid > Generate Edge Constraints” seçeneği 

seçilerek nesnelerin birbiri ile birlikte çalışması sağlanabilir. Modal analiz sonucu kütle 

katılım oranı yüksek olan modlar kontrol edilirse modelden ayrık bir şekilde davranan 

parçalar tespit edilebilir ve bu özellik sayesinde düzeltilebilirler. Bu özelliğin çok fazla 

kullanılması modelin frekans değerlerini yükseltebilir. Bu nedenle sadece zorunlu 

kalınan yerlerde kullanılması tavsiye edilir. 
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Şekil 3.14 Karmaşık yapıların modellenmesinde takip edilecek yol 
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Şekil 3.15 Süleymaniye Camii bitirilmiş model 

Karmaşık yapıların modellenmesi, zor görünmelerine rağmen yeterli miktarda zaman ve 

enerji harcayarak yapılması mümkündür.  Bu bilgiler ışığında modelleme aşamasında 

izlenecek yol daha belirgin olacak, daha az hata yapılacak ve modelleme aşaması daha 

kolay geçecektir. Bu gibi yapılarda hata yapmak daha kolay olduğundan dolayı geri 

dönüşler veya düzeltmeler daha çok yapılmak zorunda kalınabilir. Bazen de bir hatanın 

düzeltilmesi çok fazla zaman kaybına neden olabilir. Tüm bu bilgiler daha gerçekçi 

sonuçların daha kısa zaman içerisinde elde edilmesini mümkün kılmaktadır. 
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4.  

BÖLÜM 4 

SÜLEYMANİYE CAMİİ’NİN FARKLI KARAKTERİSTİK ÖZELLİKLERE SAHİP 

DEPREMLERİN ETKİLERİ ALTINDA DAVRANIŞININ İNCELENMESİ 

 Yapısal Modelleme ve Analiz 

Süleymaniye Camii gibi karmaşık bir yapının modellenmesi son derece zordur. 

Modelleme bazı kabuller ve idealleştirmeler ile yapılmalıdır. Kabuller, edinilemeyecek 

veya edinilmesi zor veriler için geçmiş çalışmalar kullanılarak yapılır. İdealleştirme 

yapmak ise modelleme aşamasında bazı kolaylıklar sağlar. 

Hiçbir model yüzde yüz gerçeği yansıtamayacağı için amaç gerçekçiliğe en yakın sonucu 

elde etmek olmalıdır. Bunun için önce yapının projesini almak ve yapı hakkında bilgi 

toplamak gerekir. Yeterli veriye sahip olduktan sonra yöntem seçilerek modelleme 

işlemine başlanır. Bu çalışmada sonlu elemanlar yöntemi tercih edilmiştir. 

Sonlu elemanlar yöntemi ile modelleme yapılır iken doğru şekilde yapıyı parçalara 

ayırarak modellemek önem arz eder. Yapının hassas veya geometrik olarak zor olan 

bölgelerinde yapı daha küçük parçalara ayrılarak modelleme yapılabilir. Modelleme 

yaparken parçaların bağlantı noktalarının düzgün yapılması önemlidir. Bu sayede yük 

aktarımları düzgün olur ve analiz sonuçlarında gerçeğe en yakın sonuçlar elde edilir. 

Yapısal modelde kullanılan elemanlara ait model tipleri ve malzeme özellikleri Çizelge 

4.1 de görüldüğü gibidir. Burada verilen malzeme özellikleri Dabanlı [16] tarafından 

kullanılan malzeme özellikleri referans alınarak tespit edilmiş daha sonra Selahiye vd. [1] 

tarafından sunulan deneysel ölçüm sonuçları referans alınarak Çizelge 4.1’de görüldüğü 

gibi güncellenmiştir.  
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Çizelge 4.1 Modelde kullanılan malzeme parametreleri 

Yapı  
elemanı 

Eleman  
tipi 

Model  
tipi 

Elastisite 
modülü (MPa) 

Öz kütle 
(kg/m3) 

Poisson  
oranı 

Duvarlar Taş Katı 9500 2200 0,2 

Minareler Taş Katı 9500 2200 0,2 

Kubbeler Tuğla Kabuk 3000 1800 0,18 

 Sonlu Elemanlar Modeli 

Süleymaniye Camii bilgisayar ortamında Sap2000 uygulaması ile sonlu elemanlar 

yöntemine uygun olarak modellenmiştir. Modellemenin tamamı Sap2000 uygulaması 

üzerinde yapılmıştır. Sadece modelleme aşamasında AutoCAD uygulaması üzerinden 

yardımcı çizgiler içeri aktarılmıştır. Şekil 4.5-4.8’de yapının modellenme aşamaları 

gösterilmiştir. 

Modelde 48152 bağlantı noktası (point), 2658 kabuk (shell) eleman, 23500 katı (solid) 

eleman mevcuttur. Model X ekseninde 114,08 metre, Y ekseninde 69,13 metre, Z 

ekseninde 73,25 metrelik alan içerisinde yer almaktadır. Minare tepelerindeki alem 

kısmı statik açıdan fazla etkili olmayacağından dolayı modelde ihmal edilmiştir. 

 

Şekil 4.1 Global koordinatlar ve gerilmeler [67] 
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Yapı modelinde kullanılan global koordinatlar ile gerilmelerin pozitif yönleri Şekil 4.1’de 

görüldüğü gibidir. Katı ve kabuk elemanların işaret uyumları ve yön kabulleri, Sap2000 

uygulamasının kabullerine bağlı kalınarak Şekil 4.2 ve Şekil 4.3’de gösterilmiştir. Şekil 4.1 

ve Şekil 4.4’de görüldüğü gibi yapının sonlu elemanlar modelinde oluşacak çeşitli 

gerilmeler aşağıda özetlenmiştir. 

S11 : (x) yönünde gerilme 

S22 : (y) yönünde gerilme 

S33 : (z) yönünde gerilme 

S12 : (x-y) düzleminde kayma gerilmesi 

S13 : (x-z) düzleminde kayma gerilmesi 

S23 : (y-z) düzleminde kayma gerilmesi 

 

 

Şekil 4.2 Katı (solid) eleman işaret ve yönleri [67] 
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Şekil 4.3 Kabuk (shell) eleman işaret ve yönleri [67] 

 

                                     (a)                                                        (b) 

Şekil 4.4 a) S22 düşey gerilmesi b) S23 kayma gerilmesi [67] 
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Şekil 4.5 Süleymaniye Camii modelleme aşamaları 1 ve 2 
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Şekil 4.6 Süleymaniye Camii modelleme aşamaları 3 ve 4 
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Şekil 4.7 Süleymaniye Camii modelleme aşamaları 5 ve 6 
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Şekil 4.8 Süleymaniye Camii modelleme aşamaları 7 ve 8 
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 Dinamik Analiz 

Yapının serbest titreşim periyotları, frekansları ve mod şekillerini belirlemek için modal 

analiz yapılır. Çıkan modlardan eksen yönlerindeki ve Z ekseni etrafındaki burulma 

modunda en fazla kütle katılım oranına sahip olanlar belirlenir. Bu modların frekansı 

gerçek yapının ölçülen serbest titreşim frekanslarına yakın çıkmış ise oluşturulan model 

yeteri kadar gerçekçi sonuç veriyor denilebilir.  

Çizelge 4.2 Modların kütle katılım oranları 

Mod No UX (%) UY (%) UZ (%) RZ (%) 

Mod 14 54,17 0,526 5,2 E-7 0,003 

Mod 15 0,749 40,912 1,4 E-4 4,559 

Mod 16 0,052 0,154 8,4 E-4 12,09 

Mod 66 0,032 0,051 5,026 0,083 

Yapının modal analiz sonuçları neticesinde, ilk 100 modda (X) yönünde toplam kütle 

katılım oranının yapı kütlesinin %77,12’si ve (Y) yönünde toplam kütle katılım oranının 

da yapı kütlesinin %77,16’sı olduğu hesaplanmıştır. (X) yönünde en fazla kütle katılım 

oranına sahip olan modun %54,17 kütle katılım oranı ile 14. mod olduğu tespit edilmiştir. 

(Y) yönünde ise en fazla kütle katılım oranına sahip olan modun ise %40,91 kütle katılım 

oranı ile 15. mod olduğu tespit edilmiştir. Kütle katılım oranı en fazla olan modlar Çizelge 

4.2’de gösterilmiştir. Mod 68’den itibaren toplam kütle katılım oranları çok düşük 

miktarda artmaya başladığı için çalışmaya 100 mod ile devam edilmiştir. 

İlk 100 mod için hesaplanan frekanslar ile kütle katılım oranları Çizelge 4.3 ve Çizelge 4.4 

gösterilmektedir. Buna göre yapının 1. hakim titreşim modu X yönünde öteleme 

davranışı göstermektedir (Şekil 4.9). 2. hakim titreşim modu Y yönünde öteleme 

davranışı göstermektedir (Şekil 4.10). 3. hakim titreşim modu burulma (Şekil 4.11), 4. 

hakim titreşim modu ise Z yönünde öteleme davranışı göstermektedir (Şekil 4.12).  
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Çizelge 4.3 Süleymaniye Camii Periyot ve Kütle Katılım Oranları (1-50) 

MOD PERİOD FREKANS UX ΣUX UY ΣUY UZ ΣUZ RZ ΣRZ 

1 2,3602 0,4237 0,01082 0,01082 5,8E-06 5,8E-06 3,5E-09 3,5E-09 0,0075 0,0075 

2 2,3299 0,4292 0,01008 0,0209 0,00068 0,00069 1,1E-10 3,6E-09 0,00544 0,01294 

3 2,2897 0,4367 2,5E-06 0,0209 0,01067 0,01135 2,3E-07 2,3E-07 0,00216 0,0151 

4 2,2606 0,4424 0,00067 0,02157 0,00938 0,02074 2,3E-07 4,6E-07 0,004 0,0191 

5 1,3983 0,7152 0,00453 0,0261 0,00064 0,02138 6,4E-08 5,3E-07 0,00975 0,02885 

6 1,3958 0,7164 0,00497 0,03107 0,00019 0,02156 1,1E-07 6,4E-07 0,00657 0,03542 

7 1,3947 0,717 0,00063 0,03171 0,00478 0,02635 3,2E-07 9,6E-07 0,0099 0,04532 

8 1,3919 0,7185 0,00021 0,03192 0,00474 0,03108 2,6E-07 1,2E-06 0,01181 0,05713 

9 0,4194 2,3844 0,01258 0,0445 6,2E-13 0,03108 4,5E-08 1,3E-06 9,6E-09 0,05713 

10 0,3757 2,662 0,01165 0,05615 0,00024 0,03132 2,2E-07 1,5E-06 0,0038 0,06093 

11 0,3713 2,6935 0,01207 0,06822 0,00068 0,032 1,4E-07 1,6E-06 0,00449 0,06542 

12 0,3651 2,7388 9,7E-05 0,06832 0,00668 0,03868 1,1E-05 1,3E-05 0,00115 0,06657 

13 0,3599 2,7785 0,00049 0,06881 0,00507 0,04375 1,4E-05 2,7E-05 0,00118 0,06775 

14 0,2971 3,3664 0,5417 0,61051 0,00526 0,04901 5,2E-09 2,7E-05 0,00031 0,06806 

15 0,2868 3,4868 0,00749 0,618 0,4091 0,45813 1,4E-06 2,8E-05 0,04559 0,11365 

16 0,2354 4,2472 0,00052 0,61852 0,00154 0,45967 8,4E-06 3,7E-05 0,1209 0,23454 

17 0,23 4,3477 0,0006 0,61912 0,00088 0,46055 6,7E-06 4,3E-05 0,00034 0,23489 

18 0,2299 4,3489 0,00251 0,62163 0,00027 0,46083 3E-05 7,3E-05 0,00015 0,23504 

19 0,2294 4,3596 0,00027 0,6219 0,00178 0,46261 2,4E-06 7,5E-05 0,0079 0,24294 

20 0,2291 4,3652 0,00051 0,62241 0,00121 0,46381 2,6E-06 7,8E-05 0,00546 0,2484 

21 0,2251 4,4416 1,4E-05 0,62242 0,00013 0,46395 0,00031 0,00039 0,00303 0,25143 

22 0,2139 4,6742 0,021 0,64342 4E-08 0,46395 2,7E-05 0,00042 1,1E-07 0,25143 

23 0,2035 4,9129 0,00018 0,6436 0,00315 0,46709 5,7E-06 0,00042 0,11455 0,36599 

24 0,1961 5,0987 6,5E-05 0,64367 2,5E-05 0,46712 1,9E-06 0,00042 0,00233 0,36832 

25 0,1949 5,1313 4,4E-05 0,64371 7,1E-05 0,46719 1,3E-06 0,00042 0,00142 0,36974 

26 0,1827 5,4731 5,8E-10 0,64371 1,5E-05 0,4672 7,4E-13 0,00042 0,00068 0,37042 

27 0,1803 5,5461 0,00568 0,64939 0,00196 0,46916 5E-05 0,00047 0,00207 0,37249 

28 0,1722 5,8066 1,6E-05 0,6494 0,04344 0,51261 5,1E-07 0,00048 0,05253 0,42503 

29 0,1677 5,9647 0,0005 0,64991 0,00115 0,51376 3,4E-05 0,00051 0,00057 0,42559 

30 0,1625 6,1538 0,00501 0,65492 0,01962 0,53339 0,00025 0,00076 0,00342 0,42901 

31 0,1608 6,2179 0,00028 0,6552 0,02643 0,55981 3,4E-05 0,0008 0,00246 0,43147 

32 0,1571 6,3635 0,05264 0,70784 0,00032 0,56014 0,00013 0,00093 4,8E-06 0,43147 

33 0,1528 6,5462 0,00012 0,70795 0,00311 0,56325 6,6E-06 0,00093 0,00585 0,43732 

34 0,1524 6,563 0,00225 0,71021 0,03701 0,60025 0,00023 0,00117 0,00777 0,44509 

35 0,1435 6,9677 7,7E-06 0,71021 1,8E-05 0,60027 6,1E-05 0,00123 0,0028 0,44789 

36 0,1425 7,0192 4,7E-08 0,71021 0,00808 0,60835 7,6E-05 0,00131 0,00308 0,45097 

37 0,1417 7,056 0,00011 0,71033 7,1E-05 0,60842 0,00046 0,00177 0,00012 0,45108 

38 0,1395 7,1695 1,2E-05 0,71034 0,00037 0,60879 0,0001 0,00187 3,4E-05 0,45112 

39 0,1394 7,1712 3,4E-07 0,71034 0,0016 0,61039 0,00057 0,00244 0,00025 0,45137 

40 0,1389 7,1983 4E-06 0,71034 0,00023 0,61062 6,9E-05 0,0025 3,3E-05 0,4514 

41 0,1364 7,3332 0,00146 0,7118 0,00011 0,61073 8,8E-06 0,00251 0,00033 0,45173 

42 0,1333 7,4996 0,00022 0,71202 0,00137 0,6121 0,00596 0,00847 2,8E-05 0,45175 

43 0,1309 7,6423 0,00178 0,7138 0,00269 0,61479 0,00463 0,0131 0,00187 0,45363 

44 0,1274 7,8468 0,00132 0,71512 0,00349 0,61828 0,00017 0,01327 0,01421 0,46784 

45 0,1261 7,9301 0,00083 0,71595 0,00237 0,62065 1,9E-05 0,01329 0,0057 0,47354 

46 0,1255 7,9695 1,7E-05 0,71597 0,00056 0,62121 0,00058 0,01387 0,00554 0,47908 

47 0,1248 8,0119 0,00075 0,71672 0,00411 0,62532 0,00012 0,014 0,01267 0,49174 

48 0,1237 8,083 4,6E-05 0,71676 0,00635 0,63166 0,00013 0,01413 0,00121 0,49295 

49 0,1231 8,1264 0,00028 0,71705 0,00032 0,63198 0,00017 0,0143 0,00028 0,49322 

50 0,1221 8,1917 2,4E-05 0,71707 0,0004 0,63239 0,00028 0,01458 0,00034 0,49356 
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Çizelge 4.4 Süleymaniye Camii Periyot ve Kütle Katılım Oranları (51-100) 

MOD PERİOD FREKANS UX ΣUX UY ΣUY UZ ΣUZ RZ ΣRZ 

51 0,1217 8,2146 0,01348 0,73056 0,0001 0,63249 2,3E-05 0,01461 6,9E-05 0,49363 

52 0,1188 8,4198 8,8E-05 0,73064 0,00242 0,63491 0,01711 0,03171 0,00166 0,49529 

53 0,1179 8,4802 7,2E-05 0,73072 0,01301 0,64792 0,00011 0,03183 0,01592 0,51121 

54 0,1175 8,509 2,2E-06 0,73072 0,00058 0,6485 0,0002 0,03202 0,00099 0,51221 

55 0,1168 8,5648 6,3E-05 0,73078 0,00035 0,64885 0,00624 0,03826 0,00122 0,51342 

56 0,1162 8,6069 1,5E-06 0,73078 0,00014 0,649 0,00073 0,03899 0,00013 0,51356 

57 0,1154 8,6658 0,00034 0,73112 0,00213 0,65113 0,01832 0,05731 0,00151 0,51507 

58 0,1136 8,8066 0,00431 0,73543 0,00304 0,65418 0,01132 0,06863 0,00015 0,51522 

59 0,1134 8,8215 0,00205 0,73748 0,00015 0,65433 0,00862 0,07725 0,0099 0,52512 

60 0,1133 8,8261 0,00731 0,74479 0,00108 0,6554 0,00361 0,08086 0,00049 0,5256 

61 0,1126 8,8783 1,7E-05 0,74481 0,003 0,6584 0,00927 0,09013 0,00068 0,52628 

62 0,1123 8,9085 0,00025 0,74506 0,00721 0,66561 0,00251 0,09264 0,00034 0,52662 

63 0,1117 8,9555 0,00014 0,7452 1,7E-06 0,66561 0,02725 0,1199 0,00113 0,52774 

64 0,1116 8,9644 0,00331 0,74851 0,00368 0,66929 0,00904 0,12894 4,9E-05 0,52779 

65 0,1113 8,9868 0,00207 0,75058 1,8E-05 0,66931 0,0076 0,13654 8,6E-05 0,52788 

66 0,111 9,0126 0,00032 0,7509 0,00051 0,66982 0,0503 0,1868 0,00083 0,52871 

67 0,1102 9,0731 0,00074 0,75165 0,02147 0,69129 0,02467 0,21147 0,00022 0,52893 

68 0,1054 9,4878 2,3E-05 0,75167 0,02476 0,71606 0,00022 0,21168 0,00712 0,53605 

69 0,1037 9,6402 0,00185 0,75352 0,00353 0,71958 0,00925 0,22094 0,0046 0,54065 

70 0,1028 9,7301 9,1E-05 0,75361 0,00169 0,72127 0,00238 0,22332 0,00139 0,54204 

71 0,1007 9,9337 0,00027 0,75388 0,00269 0,72396 0,0001 0,22342 0,01178 0,55382 

72 0,0996 10,041 0,00297 0,75685 0,00899 0,73295 5,2E-05 0,22347 0,0004 0,55421 

73 0,0991 10,089 7,9E-05 0,75693 1,6E-05 0,73297 0,00016 0,22363 1,5E-05 0,55423 

74 0,0987 10,127 0,00064 0,75757 0,00037 0,73334 1,8E-05 0,22365 4,5E-05 0,55427 

75 0,0986 10,146 2,1E-05 0,75759 0,00056 0,7339 0,00016 0,22381 1,9E-05 0,55429 

76 0,0979 10,215 0,00042 0,75801 0,00195 0,73585 0,00053 0,22434 0,00248 0,55678 

77 0,0974 10,264 6,5E-05 0,75808 0,00015 0,736 0,00025 0,22459 0,0009 0,55768 

78 0,0974 10,27 8,3E-05 0,75816 0,00048 0,73649 3,3E-09 0,22459 0,00112 0,5588 

79 0,0967 10,343 0,00034 0,75849 0,00439 0,74087 1,6E-05 0,2246 0,0004 0,55919 

80 0,0963 10,38 2,3E-05 0,75852 0,0018 0,74267 1,7E-05 0,22462 0,00744 0,56663 

81 0,0956 10,462 0,0006 0,75912 0,00031 0,74298 0,00104 0,22566 0,00187 0,56851 

82 0,0955 10,475 0,00075 0,75987 0,00045 0,74343 0,00123 0,22689 1,5E-08 0,56851 

83 0,0953 10,495 0,00129 0,76116 0,00016 0,7436 0,00345 0,23034 3,8E-05 0,56854 

84 0,0951 10,51 0,00278 0,76394 0,00036 0,74396 4,8E-05 0,23038 0,00051 0,56906 

85 0,0946 10,571 0,00084 0,76478 0,00255 0,74651 0,00089 0,23127 0,00091 0,56997 

86 0,094 10,634 0,00086 0,76564 0,00168 0,74819 0,00027 0,23154 0,00302 0,57299 

87 0,0939 10,651 7,2E-06 0,76564 3,2E-05 0,74822 0,00022 0,23176 0,00028 0,57327 

88 0,0936 10,684 6,6E-06 0,76565 0,00014 0,74836 0,00515 0,23691 0,00078 0,57405 

89 0,0933 10,714 0,00045 0,7661 7,4E-05 0,74843 0,00413 0,24104 0,00062 0,57467 

90 0,0929 10,769 0,00038 0,76648 0,00014 0,74857 0,01016 0,2512 0,00284 0,57751 

91 0,0926 10,794 1,3E-05 0,76649 6,9E-06 0,74858 0,00433 0,25554 0,0089 0,58641 

92 0,0922 10,841 0,00013 0,76662 0,00032 0,7489 0,00262 0,25816 0,00055 0,58695 

93 0,0921 10,856 0,00066 0,76728 2,5E-05 0,74892 1,3E-05 0,25817 0,00021 0,58716 

94 0,092 10,873 0,00016 0,76745 0,00077 0,74969 3,9E-06 0,25818 0,00067 0,58783 

95 0,0918 10,894 0,00083 0,76828 0,0043 0,75399 0,00043 0,25861 0,00284 0,59067 

96 0,0911 10,983 5,2E-06 0,76828 5,8E-05 0,75404 0,00429 0,26289 0,00046 0,59113 

97 0,0904 11,063 0,00104 0,76932 0,00109 0,75513 8,5E-05 0,26298 6,7E-05 0,5912 

98 0,0901 11,104 0,00035 0,76967 1,4E-05 0,75515 6,1E-06 0,26298 1,4E-05 0,59121 

99 0,0897 11,146 0,00155 0,77123 0,00139 0,75654 0,00199 0,26497 0,00048 0,59169 

100 0,0895 11,169 6E-10 0,77123 0,01506 0,77159 9,1E-11 0,26497 0,04792 0,63961 
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Şekil 4.9 Süleymaniye Camii X ekseninde en fazla kütle katılımına sahip mod şekli 

 

Şekil 4.10 Süleymaniye Camii Y ekseninde en fazla kütle katılımına sahip mod şekli 
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Şekil 4.11 Süleymaniye Camii Z ekseni etrafındaki burulma hareketinde en fazla kütle 
katılımına sahip mod şekli 

 

Şekil 4.12 Süleymaniye Camii Z ekseninde en fazla kütle katılımına sahip mod şekli 
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Malzeme özellikleri güncellendikten sonra yapılan modal analiz neticesinde elde edilen 

hakim titreşim modlarına karşılık gelen frekansların önceki çalışmalar ile karşılaştırılması 

Çizelge 4.5’de görüldüğü gibidir. Burada elde edilen analitik frekanslar ile Selahiye vd. 

[1] tarafından belirlenen deneysel frekanslar, Sato vd. [18] tarafından Kocaeli depremi 

öncesi ve sonrasında tespit edilen deneysel frekanslar ve Şeker [29] tarafından 

belirlenen analitik frekanslar bir arada sunulmuştur. Sonuçlar incelendiğinde modelin 

gerçeğe yakın olarak oluşturulduğu anlaşılmaktadır.  

Çizelge 4.5 Modların frekansları ve geçmiş çalışmalar ile karşılaştırılması 

Mod No 
Mod 

Frekansları 
(Hz) 

Deneysel 
Frekanslar (Hz) 

[1]  

Deneysel Frekanslar (Hz) [18] 

Analitik 
Frekanslar 
(Hz) [29] 

Kocaeli 
Depremi 
Öncesi 

Kocaeli 
Depremi 
Sonrası 

Mod 14 3,366 3,38 3,43 3,36 4,07 

Mod 15 3,486 3,44 3,55 3,46 4,75 

Mod 16 4,247 4,26 - - - 

Mod 66 9,013 9,60 - - - 

 Deprem Etkisi Altında Yapının Davranışı 

4.4.1 Üç Farklı Tarihi Büyük Depremin Yapıya Etkisi 

Bu başlık altında incelenen deprem kayıtları, farklı karakterdeki deprem kayıtlarının yapı 

davranışı üzerindeki etkilerinin incelenmesi amacı ile kullanılacaktır. Deprem kayıtları 

gerçek tarihi depremler olup farklı karakteristik özelliklere sahiptirler. Depremlerin 

büyüklükleri ve yapıya uzaklıkları Şekil 4.13-18’de verilmiştir. 

Şekil 4.13, 4.14 ve 4.15’de yapıya etki ettirilen ivmelerin zamana bağlı değişimi, Şekil 

4.16, 4.17 ve 4.18’de ise yer değiştirmelerin zamana bağlı değişimleri verilmiştir. 

Şekillerde verilen ivmeler teker teker yapıya etki ettirilmiş ve yapının kendi ağırlığı da 

dikkate alınarak zaman tanım alanında dinamik analiz yapılmıştır. Yapının kritik bazı 

noktalarında oluşan yer değiştirmeler Çizelge 4.6’da verilmiştir. 
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Şekil 4.13 Düzce depremi(1999) ivme-zaman grafiği, (Mag: 7,14 MW, kırılma bölgesinin 
45 km uzağı Sakarya istasyonu kaydı, mekanizma: strike slip) [69], [70] 

 

Şekil 4.14 Kobe depremi(1995) ivme-zaman grafiği, (Mag: 6,9 MW, kırılma bölgesinin 19 
km uzağı Shin-Osaka istasyonu kaydı, mekanizma: strike slip) [69], [70] 

 

Şekil 4.15 Northridge depremi(1994) ivme-zaman grafiği, (Mag: 6,69 MW, kırılma 
bölgesinin 30 km uzağı LA - N Figueroa istasyonu kaydı, mekanizma: reverse) [69], [70] 



63 
 

 

Şekil 4.16 Düzce depremi(1999) yer değiştirme-zaman grafiği, (Mag: 7,14 MW, kırılma 
bölgesinin 45 km uzağı Sakarya istasyonu kaydı, mekanizma: strike slip) [69], [70] 

 

Şekil 4.17 Kobe depremi(1995) yer değiştirme-zaman grafiği, (Mag: 6,9 MW, kırılma 
bölgesinin 19 km uzağı Shin-Osaka istasyonu kaydı, mekanizma: strike slip) [69], [70] 

 

Şekil 4.18 Northridge depremi(1994)  yer değiştirme-zaman grafiği, (Mag: 6,69 MW, 
kırılma bölgesinin 30 km uzağı LA – N Figueroa istasyonu kaydı, mekanizma: reverse) 

[69], [70] 
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Çizelge 4.6 Analiz sonucunda yapının tepe noktalarında tespit edilen en büyük yer 
değiştirme miktarları 

Tepe Noktası 
Büyük 
Kubbe 

(1) Güney 
Minaresi 

(2) Doğu 
Minaresi 

(3) Kuzey 
Minaresi 

(4) Batı 
Minaresi 

Düzce 
Depremi  

(mm) 

Maks 
(x) 

1,87 9,48 9,25 15,79 15,83 

Min 
(x) 

-1,97 -20,1 -19,6 -16,1 -16,2 

Maks 
(y) 

1,03 14,23 14,11 15,34 15,39 

Min 
(y) 

-0,99 -22,9 -23 -19,6 -19,6 

Kobe Depremi 
(mm) 

Maks 
(x) 

9,53 251,6 251,2 203,1 202,5 

Min 
(x) 

-13,83 -217,7 -226,5 -188,4 -187,1 

Maks 
(y) 

9,97 146,4 147,7 178,2 178,5 

Min 
(y) 

-9,64 -182,8 -178,9 -189,2 -190,1 

Northridge 
Depremi  

(mm) 

Maks 
(x) 

7,13 46,79 45,33 74,78 74,69 

Min 
(x) 

-9,64 -88,3 -87,8 -81,9 -81,6 

Maks 
(y) 

8,38 46,57 45,61 39,36 39,3 

Min 
(y) 

-9,12 -106,9 -104 -43,84 -43,99 

 



65 
 

Yapıda hiçbir deprem etkisi altında olmadan yapılan analizler sonucunda meydana gelen 

çekme ve basınç gerilmeleri Çizelge 4.7’de verilmiştir. Yapının dikey yönde (S33) 

oluşturduğu maksimum basınç 2,35 MPa’dır (Şekil 4.19). Sonuçlara bakıldığında yapının 

ağır olduğu anlaşılmaktadır. Ayrıca yapının ölü ağırlığının yapı içinde çekme gerilmeleri 

oluşturduğu görülmektedir. Y ekseni (S22) doğrultusunda ölü yük nedeni ile oluşan 

maksimum gerilme 1,31 MPa’dır. 

Yapıda deprem analizleri sonucu meydana gelen en büyük çekme ve basınç gerilmeleri 

Çizelge 4.8 ve Çizelge 4.9’da görüldüğü gibidir. Elde edilen sonuçlar incelendiğinde, en 

büyük çekme gerilmelerinin Kobe depreminin X yönünde etki ettirilen bileşeni 

sonucunda elde edildiği anlaşılmaktadır.  Bu deprem sonucu oluşan gerilme dağılımları 

Şekil 4.20’de gösterilmektedir. Grafik skalası 1 MPa ve -1 MPa arasında ölçeklendirilerek 

sunulmuştur. Yapının geneli (sarı-mavi arası bölgeler) Şekil 4.20’de görüldüğü gibi 1 MPa 

altında çekme gerilmesine maruz kalmıştır. Minare duvarlarında 3 MPa civarlarında, 

pencere boşluklarının yakın olduğu yerlerde ise 1,5 MPa civarı çekme gerilmeleri 

oluşmuştur. Şekil 4.21’de görüldüğü gibi yapının temel ile birleştiği yerlerin bazı kenar 

kısımlarında 1 ile 2 MPa arasında gerilmeler oluşmuştur. 

Çizelge 4.7 Ölü yükler altında en büyük gerilmeler (MPa) 

MAKSİMUM 

Shell (Kubbeler) Solid 

S11 S22 S11 S22 S33 

Çekme Gerilmesi 0,68 0,69 1,06 1,31 1,22 

Basınç Gerilmesi 1,22 1,52 1,25 2,03 2,35 
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Şekil 4.19 Yapının ağırlığının Z ekseninde oluşturduğu basınç gerilmeleri (Çizelge 4.7, 
S33) 

 

Şekil 4.20 Kobe depremi X bileşeninin yapıda oluşturduğu en büyük çekme gerilmeleri 
(Çizelge 4.8, S11) 
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Çizelge 4.8 Deprem etkisi altında yapıda oluşan en büyük çekme gerilmeleri (MPa) 

MAKSİMUM ÇEKME 

Shell (Kubbeler) Solid 

S11 S22 S11 S22 S33 

Düzce (X) 0,75 0,89 1,3 1,91 1,37 

Düzce (Y) 0,72 0,73 1,24 1,62 1,35 

Kobe (X) 1,34 1,85 4,09 3,18 5,76 

Kobe (Y) 2,18 2,07 2,56 3,25 5,34 

Northridge (X) 1,13 1,53 3,26 2,58 3,87 

Northridge (Y) 1,79 1,22 1,96 3,52 3,14 

Kobe gibi Northridge ve Düzce depremlerinde de en büyük çekme gerilmeleri X 

ekseninde etki ettirilen depremlerden dolayı oluşmuştur. 

Y Ekseninde ise yine en büyük gerilme Şekil 4.22’de görüldüğü gibi Kobe depreminde 

oluşmuştur. Bunun nedeni tercih edilen deprem kayıtlarından kırılma noktasına en yakın 

olanının Kobe depremi kaydının olmasıdır. Bu nedenle Kobe depremi ivme kayıtları 

Düzce ve Northridge depremi ivmelerine göre daha büyük değerdedirler. Kobe 

depreminin X bileşeninin güney minaresi yüzeyinde oluşturduğu çekme gerilmeleri 

detayı Şekil 4.24’te, Y bileşeninin kuzey minaresi yüzeyinde oluşturduğu basınç 

gerilmeleri detayı ise Şekil 4.25’te gösterilmektedir. 

Yapıda oluşan çekme gerilmeleri arttıkça çatlak oluşumu ihtimali artacaktır. Bu nedenle 

en fazla çatlak oluşumu Kobe depreminde, ardından Northridge depreminde, en son 

olarak ta Düzce depreminde beklenebilir. 
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Çizelge 4.9 Deprem etkisi altında yapıda oluşan en büyük basınç gerilmeleri (MPa) 

MAKSİMUM BASINÇ 

Shell (Kubbeler) Solid 

S11 S22 S11 S22 S33 

Düzce (X) 1,4 1,65 1,79 2,15 2,94 

Düzce (Y) 1,43 1,59 1,37 2,09 2,99 

Kobe (X) 2,32 2,44 4,16 3,35 6,97 

Kobe (Y) 2,49 2,53 2,29 3,64 6,45 

Northridge (X) 2,1 2,13 4,19 2,93 4,84 

Northridge (Y) 2,06 2,22 2,17 3,78 4,45 

Yapının ağır olması nedeni ile en büyük basınçlar depremlerin hepsinde doğal olarak 

düşey eksende (S33) oluşmuştur. Basınç gerilmelerinin önemli bir kısmı yapının kendi 

ağırlığı nedeni ile oluşmuştur denilebilir. Kubbelerde (Shell kısmında) basınç gerilmelerin 

hepsi çekme gerilmelerinden daha fazla olmuştur. Yapının geri kalanında ise sadece 

Kobe depreminde (Y) S11 çekme değeri basınç değerinden az miktarda fazla çıkmıştır. 

Kubbelerde en fazla basınç Şekil 4.23’de görüldüğü gibi yapı ile veya başka bir kubbe ile 

bağlandığı yerlerde oluşmuştur. En fazla çekme gerilmeleri de basıncın büyük olduğu 

yerler ile aynı yerlerde meydana gelmiştir. Şekil 4.26’da Northridge depreminin (Y) etkisi 

altındaki kubbelerin çekme gerilmeleri detayı verilmiştir. Yapıya kıyasla kubbelerde 

oluşan basınç ve çekme gerilmelerinin çok daha düşük seviyelerde kaldığı söylenebilir. 
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Şekil 4.21 Kobe depremi X bileşeninin etkisi altında oluşan düşey yöndeki çekme 
gerilmeleri ve bazı noktalardaki değerleri (Pozitif değer çekme, negatif basınçtır. 

Çizelge 4.8, S33) 
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Şekil 4.22 Kobe depremi Y bileşeninin yapıda oluşturduğu en büyük çekme gerilmeleri 
(Çizelge 4.8, S22) 

 

Şekil 4.23 Northridge depremi Y bileşeninin kubbelerde (kabuk elemanlarda) 
oluşturduğu en büyük basınç gerilmeleri (Çizelge 4.9, S11) 
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Şekil 4.24 Kobe depremi X bileşeninin güney minaresi yüzeyinde oluşturduğu çekme 
gerilmeleri detayı (Çizelge 4.8, S33) 

 

Şekil 4.25 Kobe depreminin Y bileşeninin kuzey minaresi yüzeyinde oluşturduğu basınç 
gerilmeleri detayı (Çizelge 4.9, S33) 
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Çizelge 4.6’daki yapının yer değiştirme miktarlarına bakıldığında yapının Düzce 

depreminden pek fazla etkilenmediği ve yer değiştirme miktarlarının düşük miktarda 

kaldığı görülmüştür. Düzce deprem kaydının diğerlerine göre kırılma noktasına en uzak 

mesafede olan istasyon kayıtlarının kullanılmasının da bu sonuç üzerinde etkisi vardır. 

Ana taşıyıcı sistem bütün depremlerde rijit davranarak düşük miktarda yer değiştirme 

göstermiştir. Yapının en fazla yer değiştirme gösteren yerleri ise 1 ve 2 nolu güney ve 

doğu minarelerinin tepe noktaları olmuştur. Minare tepeleri, Kobe depremi (X) etkisi 

altında 251 mm yer değiştirme yapmıştır. 

 

Şekil 4.26 Northridge depremi Y bileşeninin ana kubbe yüzeyinde ve avlu tarafındaki 
yarım kubbe yüzeyinde oluşturduğu çekme gerilmeleri detayı (Çizelge 4.8, S11) 
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4.4.2 Yapı Zemini ve Kocaeli Depremi 

Öncelikle Süleymaniye Camii’nin ITRF (Uluslararası Karasal Referans Çerçevesi) 

koordinat sistemine göre konumu tespit edilmiştir (Şekil 4.27). Daha sonra yapıyı içine 

alacak şekilde 1.5km x 1.5km=2.25 km2’lik bir alan Şekil 4.28’de görüldüğü gibi 

oluşturulmuştur. Bu alanın ITRF koordinat sistemine göre X yönündeki koordinatları 

412000m  ve 413500m aralığında, Y yönündeki koordinatları ise 4542000m ve 

4543500m aralığındadır (Şekil 4.29). 

 

Şekil 4.27 Süleymaniye Camii’nin ITRF koordinat sistemine göre konumu 
(x=412854.065 m, y=4542861.450 m) 

    

Şekil 4.28 Süleymaniye Camii’ni içerisine alan bölgenin seçimi 
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Oluşturulan alan içerisine daha önce yapılmış olan zemin etüt çalışmaları kullanılarak 

model oluşturulacaktır. Bu alan içerisinde 35 adet sondaj verisi (Şekil 4.30), 18 adet ReMi 

(Refraction Micretremor) verisi (Şekil 4.31) ve 2 adet derin sondaj PS Log verisi (Şekil 

4.32) yer almaktadır. Bu veriler, İstanbul Büyükşehir Belediyesi (İBB) veri tabanında 

mevcut olup, Uluslararası MarDim (Marmara Disaster Mitigation) projesi kapsamında 

yapılan protokole bağlı olarak analiz edilmiştir. Modelin oluşturulmasında ve deprem 

dalgalarının büyütmesi ve bölgedeki yer hareketlerinin belirlenmesinde Doç. Dr. 

Abdurrahman Şahin ve çalışma grubu tarafından halen geliştirilmekte olan yazılım 

sistemleri kullanılmıştır [71]. Bu verilerin analiz edilmesi sonucunda, seçili alanın 3 

boyutlu zemin modeli Şekil 4.33’deki, ana kaya yüzeyi de Şekil 4.34’de görüldüğü gibi 

elde edilmiştir. 

 

 

X1=412000m  X2=413500m 

Y1=4542000m Y2=4543500m 

 

Şekil 4.29 Seçilen bölgenin koordinatları 

 

 

Şekil 4.30 Seçili bölgede yer alan 35 
adet sondaj verisinin konumları 

 

 

Şekil 4.31 Seçili bölgede yer alan 18 
adet ReMi verisinin konumları 

 

 

Şekil 4.32 Seçili bölgede yer alan 2 adet 
PsLog verisinin konumları 
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Şekil 4.33 Seçilen bölge için oluşturulmuş olan zemin modeli 

Şekil 4.33‘de verilen Zemin modeli incelendiğinde, ana kayanın yaklaşık olarak yüzey 

üzerinde olduğu ve bölgenin rijit bir zemin yapısına sahip olduğu anlaşılmaktadır. Şekil 

4.34’deki ana kaya yüzey eğrisi incelendiğinde yaklaşık olarak zemin modelinin yüzey 

tabakası ile aynı kotlarda olduğu anlaşılmaktadır. Rijit bir bölgede zemin hareketlerinin 

düşük periyot ve yüksek frekanslarda olduğu düşünüldüğünde, bu gölgedeki tarihi 

yapılarında rijit yapılar olması, deprem esnasında yaklaşık frekanslar dolayısı ile deprem 

etkilerinde büyütmelere ve rezonans riskine sebep olabilecektir.  
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Şekil 4.34 Ana kaya yüzey eğrisi 

Zemin modeli oluşturulduktan sonra Kocaeli depremi sırasında bölgeye en yakın 

istasyonlardan birisi olan Zeytinburnu istasyonundan ölçülen kayıtlar, Ters Fourier 

dönüşümü ile ana kayaya aktarılacak ve oradan da, ilgili bölgeye taşınacaktır. Buradan 

da, seçili bölgenin deprem tehlike simülasyonları yapılacak ve Süleymaniye Camii'ne etki 

edecek olan yer hareketleri tespit edilerek deprem simülasyonları yapılacaktır. 

İstanbul’un Zeytinburnu ilçesinde bulunan istasyonun koordinatları ve Şişman [72] 

tarafından bölgesel veri çalışmalarından yararlanılarak oluşturulan bu noktaya ait zemin 

tabakaları, yükseklikleri ve kayma dalgası hızları grafikleri Şekil 4.35’de gösterilmiştir. 
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Şekil 4.35 Zeytinburnu istasyonu zemin modeli [72] 

“Şekilde gösterilen modelin ilk 6.08 metresi yapay dolgu tabakası ile kaplı olup birim 

hacim ağırlığı 1.8 t/m3 ve kayma dalgası hızı 236 m/s’dir. Dolgudan sonra ilk olarak 10.97 

metre boyunca Bakırköy Formasyonu başlamıştır, birim hacim ağırlığı 1.9 t/m3 ve kayma 

dalgası hızı 278 m/s’dir. Ardından gelen 16.63 metrelik Güngören Formasyonu’nun birim 

hacim ağırlığı 1.9 t/m3 ve kayma dalgası hızı 310 m/s’dir. Modelin sonlarına doğru 

derinliği 35.55 metre, birim hacim ağırlığı 1.95 t/m3 ve kayma dalgası hızı 348 m/s olan 

Çukurçeşme Formasyonu’na rastlanmıştır. Son formasyon olarak ise uzunluğu modelin 

en yüksek değeri olan, kayma dalgası hızı 630 m/s ve birim hacim ağırlığı 2 t/m3 

değerinde, 165.04 metre kalınlığında Gürpınar Formasyonu görülmektedir. Toplam 

234.27 metre derinlikte bulunan ana kayanın ise birim hacim ağırlığı 2.2 t/m3 ve kayma 

dalgası hızı 870 m/s olarak belirlenmiştir” [51]. 
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 X Yönündeki Deprem Kaydı 

1999 Kocaeli depremi sırasında Zeytinburnu İstasyonunda alınan deprem kaydının X 

yönündeki bileşeni ve bu bileşene Ters Fourier dönüşümü uygulanması sonucu ana 

kayaya taşınan ivme dağılımı Şekil 4.36’da gösterilmektedir. 

 

Şekil 4.36 Zeytinburnu istasyonunda ölçülen deprem kaydının x yönündeki bileşeni ve 
ana kayaya taşınmış hali 

Ana kayaya taşınan Kocaeli deprem kaydı yatay bileşeni daha sonra seçili alana taşınmış, 

ana kayanın üzerinde zemin tabası olan noktalarda büyütme işlemi gerçekleştirilmiştir. 

Süleymaniye Camii’nin bulunduğu konumda genel olarak ana kaya yüzeye yakın 

olduğundan, deprem hareketi yaklaşık olarak her noktada eşit yer değiştirme yapmıştır. 

En büyük yer değiştirme dağılımı Şekil 4.37’de görüldüğü gibidir. En büyük yer 

değiştirme, depremin 31.75 inci saniyesinde görülmüştür ve değeri yaklaşık olarak 17.64 

cm’dir. En büyük hız dağılımı Şekil 4.38’de görüldüğü gibidir. En büyük hız, depremin 

32.75 inci saniyesinde görülmüştür ve değeri yaklaşık olarak 12.16 cm/s’dir. En büyük 
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ivme dağılımı Şekil 4.39’da görüldüğü gibidir. En büyük ivme, depremin 30.915’inci 

saniyesinde görülmüştür ve değeri yaklaşık olarak 0.085 g’dir. 

 

Şekil 4.37 Seçili bölgede gözlemlenen en büyük yer değiştirme dağılımı 
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Şekil 4.38 Seçili bölgede gözlemlenen en büyük hız dağılımı 
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Şekil 4.39 Seçili bölgede gözlemlenen en büyük ivme dağılımı 

Seçili alan üzerinde Kocaeli depreminin yatay (X) bileşeninin her 10 sn deki etkisi ile 

meydana gelen ivme dağılımları ve Süleymaniye Camii ana yapısının yapmış olduğu yer 

değiştirme davranışları Şekil 4.40’da gösterildiği gibidir. Süleymaniye Camii tabanının 

oturduğu yüzeyde tespit edilen ivme grafiği Şekil 4.46’da, yer değiştirme grafiği ise Şekil 

4.47’de gösterildiği gibidir. 
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Şekil 4.40.a Depremin X bileşeni etkisiyle t=10sn anında bölgede oluşan ivme dağılımı 
(g) ve ana yapının yer değiştirme şekli (Değerler deprem yönünde ve mm cinsindendir) 
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Şekil 4.40.b Depremin X bileşeni etkisiyle t=20sn anında bölgede oluşan ivme dağılımı 
(g) ve ana yapının yer değiştirme şekli (Değerler deprem yönünde ve mm cinsindendir) 
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Şekil 4.40.c Depremin X bileşeni etkisiyle t=30sn anında bölgede oluşan ivme dağılımı 
(g) ve ana yapının yer değiştirme şekli (Değerler deprem yönünde ve mm cinsindendir) 
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Şekil 4.40.d Depremin X bileşeni etkisiyle t=40sn anında bölgede oluşan ivme dağılımı 
(g) ve ana yapının yer değiştirme şekli (Değerler deprem yönünde ve mm cinsindendir) 
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Şekil 4.40.e Depremin X bileşeni etkisiyle t=50sn anında bölgede oluşan ivme dağılımı 
(g) ve ana yapının yer değiştirme şekli (Değerler deprem yönünde ve mm cinsindendir) 
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Şekil 4.40.f Depremin X bileşeni etkisiyle t=60sn anında bölgede oluşan ivme dağılımı 
(g) ve ana yapının yer değiştirme şekli (Değerler deprem yönünde ve mm cinsindendir) 



88 
 

 

 

Şekil 4.40.g Depremin X bileşeni etkisiyle t=70sn anında bölgede oluşan ivme dağılımı 
(g) ve ana yapının yer değiştirme şekli (Değerler deprem yönünde ve mm cinsindendir) 
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Şekil 4.40.h Depremin X bileşeni etkisiyle t=80sn anında bölgede oluşan ivme dağılımı 
(g) ve ana yapının yer değiştirme şekli (Değerler deprem yönünde ve mm cinsindendir) 
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Şekil 4.40.i Depremin X bileşeni etkisiyle t=90sn anında bölgede oluşan ivme dağılımı 
(g) ve ana yapının yer değiştirme şekli (Değerler deprem yönünde ve mm cinsindendir) 
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Şekil 4.40.j Depremin X bileşeni etkisiyle t=100sn anında bölgede oluşan ivme dağılımı 
(g) ve ana yapının yer değiştirme şekli (Değerler deprem yönünde ve mm cinsindendir) 
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 Y Yönündeki Deprem Kaydı 

1999 Kocaeli depremi sırasında Zeytinburnu İstasyonunda alınan deprem kaydının Y 

yönündeki bileşeni ve bu bileşene Ters Fourier dönüşümü uygulanması sonucu ana 

kayaya taşınan ivme dağılımı Şekil 4.41’de gösterilmektedir. 

 

Şekil 4.41 Zeytinburnu istasyonunda ölçülen deprem kaydının y yönündeki bileşeni ve 
ana kayaya taşınmış hali 

Camii’nin bulunduğu konumda genel olarak ana kaya yüzeye yakın olduğundan, deprem 

hareketi yaklaşık olarak her noktada eşit yer değiştirme yapmıştır. En büyük yer 

değiştirme dağılımı Şekil 4.42’de görüldüğü gibidir. En büyük yer değiştirme, depremin 

30.37’nci saniyesinde görülmüştür ve değeri yaklaşık olarak 16.99 cm’dir. En büyük hız 

dağılımı Şekil 4.43’de görüldüğü gibidir. En büyük hız, depremin 28.38 inci saniyesinde 

görülmüştür ve değeri yaklaşık olarak 14.46 cm/s’dir. En büyük ivme dağılımı Şekil 

4.44’de görüldüğü gibidir. En büyük ivme, depremin 28.12’nci saniyesinde görülmüştür 

ve değeri yaklaşık olarak 0.086 g’dir.  
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Şekil 4.42 Seçili bölgede gözlemlenen en büyük yer değiştirme dağılımı (cm) 
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Şekil 4.43 Seçili bölgede gözlemlenen en büyük hız dağılımı (cm/s) 
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Şekil 4.44 Seçili bölgede gözlemlenen en büyük ivme dağılımı (g) 

Seçili alan üzerinde Kocaeli depreminin yatay (Y) bileşeninin her 10 sn deki etkisi ile 

meydana gelen ivme dağılımları ve Süleymaniye Camii ana yapısının yapmış olduğu yer 

değiştirme davranışları Şekil 4.45’de gösterildiği gibidir. Süleymaniye Camii tabanının 

oturduğu yüzeyde tespit edilen ivme grafiği Şekil 4.46’da, yer değiştirme grafiği ise Şekil 

4.47’de gösterildiği gibidir. 
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Şekil 4.45.a Depremin Y bileşeni etkisiyle t=10sn anında bölgede oluşan ivme dağılımı 
(g) ve ana yapının yer değiştirme şekli (Değerler deprem yönünde ve mm cinsindendir) 
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Şekil 4.45.b Depremin Y bileşeni etkisiyle t=20sn anında bölgede oluşan ivme dağılımı 
(g) ve ana yapının yer değiştirme şekli (Değerler deprem yönünde ve mm cinsindendir) 
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Şekil 4.45.c Depremin Y bileşeni etkisiyle t=30sn anında bölgede oluşan ivme dağılımı 
(g) ve ana yapının yer değiştirme şekli (Değerler deprem yönünde ve mm cinsindendir) 
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Şekil 4.45.d Depremin Y bileşeni etkisiyle t=40sn anında bölgede oluşan ivme dağılımı 
(g) ve ana yapının yer değiştirme şekli (Değerler deprem yönünde ve mm cinsindendir) 
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Şekil 4.45.e Depremin Y bileşeni etkisiyle t=50sn anında bölgede oluşan ivme dağılımı 
(g) ve ana yapının yer değiştirme şekli (Değerler deprem yönünde ve mm cinsindendir) 
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Şekil 4.45.f Depremin Y bileşeni etkisiyle t=60sn anında bölgede oluşan ivme dağılımı 
(g) ve ana yapının yer değiştirme şekli (Değerler deprem yönünde ve mm cinsindendir) 
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Şekil 4.45.g Depremin Y bileşeni etkisiyle t=70sn anında bölgede oluşan ivme dağılımı 
(g) ve ana yapının yer değiştirme şekli (Değerler deprem yönünde ve mm cinsindendir) 
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Şekil 4.45.h Depremin Y bileşeni etkisiyle t=80sn anında bölgede oluşan ivme dağılımı 
(g) ve ana yapının yer değiştirme şekli (Değerler deprem yönünde ve mm cinsindendir) 
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Şekil 4.45.i Depremin Y bileşeni etkisiyle t=90sn anında bölgede oluşan ivme dağılımı 
(g) ve ana yapının yer değiştirme şekli (Değerler deprem yönünde ve mm cinsindendir) 
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Şekil 4.45.j Depremin Y bileşeni etkisiyle t=100sn anında bölgede oluşan ivme dağılımı 
(g) ve ana yapının yer değiştirme şekli (Değerler deprem yönünde ve mm cinsindendir) 
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 Analiz Sonuçlarının Değerlendirilmesi 

1999 yılında Kocaeli’nde meydana gelen bu deprem 7,51 mag. büyüklüğünde olup 

strike slip zemin kırılma mekanizması ile oluşmuştur. Şekil 4.46’da yapıya etki ettirilen 

ivmenin zamana bağlı değişimi, Şekil 4.47’de ise yer değiştirmelerin zamana bağlı 

değişimleri verilmiştir. İvme etkisinin yanı sıra yapının kendi ağırlığı da dikkate alınarak 

zaman tanım alanında analizi yapılmıştır. Deprem kayıtlarının doğu-batı bileşenleri x 

doğrultusunda, kuzey-güney bileşenleri de y doğrultusunda yapıya etki ettirilmiştir. 

Yapının kritik bazı noktalarında oluşan yer değiştirmeler Çizelge 4.10’da verilmiştir. 

Bunun yanında yapıda oluşan maksimum gerilmeler Çizelge 4.11-4.14’de verilmiştir. 

Çizelge 4.10 Kocaeli depremi etkisi ile yapının tepe noktalarında tespit edilen en büyük 
yer değiştirme miktarları 

Tepe Noktası 
Büyük 
Kubbe 

(1) Güney 
Minaresi 

(2) Doğu 
Minaresi 

(3) Kuzey 
Minaresi 

(4) Batı 
Minaresi 

Kocaeli 
Depremi  

(mm) 

Maks 
(x) 

2,87 90,61 91,56 63,98 63,92 

Min 
(x) 

-3,41 -101 -102,5 -65,02 65,01 

Maks 
(y) 

2,28 98,49 94,99 91,66 93,03 

Min 
(y) 

-2,78 -105,3 -104,2 -110,8 -111,8 
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Şekil 4.46 Kocaeli depremi(1999) ivme-zaman grafiği [70] 

 

 

Şekil 4.47 Kocaeli depremi(1999) yer değiştirme-zaman grafiği [70] 
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Çizelge 4.11 Kocaeli depremi etkisi ile yapıda oluşan pozitif yöndeki en büyük 
gerilmeler (MPa) 

 

Katı Elemanlar (Solid) 

S11 

(Çekme) 

S22 

(Çekme) 

S33 

(Çekme) 

S12 

(Kayma) 

S13 

(Kayma) 

S23 

(Kayma) 

Kocaeli (X) 1,69 1,57 1,93 0,99 1,35 1,09 

Kocaeli (Y) 1,48 1,67 2,34 0,86 1,18 1,16 

Çizelge 4.12 Kocaeli depremi etkisi ile yapıda oluşan negatif yöndeki en büyük 
gerilmeler (MPa) 

 

Katı Elemanlar (Solid) 

S11 

(Basınç) 

S22 

(Basınç) 

S33 

(Basınç) 

S12 

(Kayma) 

S13 

(Kayma) 

S23 

(Kayma) 

Kocaeli (X) 2,11 2,47 4,29 0,9 1,47 1,13 

Kocaeli (Y) 1,64 1,89 3,91 1,07 1,21 1,32 

Yapıda deprem analizleri sonucu meydana gelen en büyük çekme gerilmeleri Çizelge 

4.11 ve Çizelge 4.13’de, en büyük basınç gerilmeleri ise Çizelge 4.12 ve Çizelge 4.14’de 

verilmiştir. Elde edilen sonuçlar incelendiğinde, en büyük çekme ve basınç gerilmeleri 

her iki yönde etki ettirilen deprem için de Z ekseni yönünde (S33) çıkmıştır.  Bu 

depremler sonucu oluşan gerilme dağılımları Şekil 4.48-4.51’de gösterilmektedir. Grafik 

skalası 1 MPa ve -1 MPa arasında ölçeklendirilerek sunulmuştur. 

Yapının geneli (sarı-mavi arası bölgeler) Şekil 4.48 ve Şekil 4.49’da görüldüğü gibi 1 MPa 

altında çekme gerilmesine maruz kalmıştır. En büyük gerilmeler minare duvarlarında 

oluşmuştur. Minareler arasında en büyük gerilmeler ise kısa olan minarelerde 

oluşmuştur. Çizelge 4.11’de verilen S33 yönündeki maksimum gerilme değerleri her iki 

depremde de kısa minarelere ait olan değerlerdir. Y ekseni yönünde etki ettirilen 

depremde oluşan çekme gerilmeleri X ekseni yönünde etki ettirilen depremden daha 

fazla çıkmıştır. Pencere boşluklarının etrafı şekillerde görüldüğü gibi 0,5 MPa’ın altında 

kalmıştır. Şekil 4.52’de görüldüğü gibi fil ayaklarının alt kısımlarında çekme bölgeleri 
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oluşmaz iken yapının çevre duvarlarının altında ise önemsiz miktarda çekme gerilmeleri 

oluşmuştur.  

Çizelge 4.13 Kocaeli depremi etkisi ile kubbelerde oluşan pozitif yöndeki en büyük 
gerilmeler (MPa) 

 

Kabuk Elemanlar (Shell) 

S11 

(Çekme) 

S22 

(Çekme) 

S12 

(Kayma) 

Kocaeli (X) 1,28 1,7 1,26 

Kocaeli (Y) 1,44 1,57 1,14 

Çizelge 4.14 Kocaeli depremi etkisi ile kubbelerde oluşan negatif yöndeki en büyük 
gerilmeler (MPa) 

 

Kabuk Elemanlar (Shell) 

S11 

(Basınç) 

S22 

(Basınç) 

S12 

(Kayma) 

Kocaeli (X) 1,37 1,71 1,27 

Kocaeli (Y) 1,54 1,9 1,15 

Yapılan malzeme (Çizelge 4.1) ve modelleme kabullerine göre modelin tamamının 

toplam ağırlığı 800668,59 kiloNewton’dur (kN). KN’u ton a çevirmek için bu değeri 

yerçekimi ivmesine yani 9,80665’e bölmek gerekir. İşlem sonucunda modelin toplam 

ağırlığı 81645,47 ton çıkmaktadır. Yapının tek tek bölümleri incelendiğinde ise; 

 Kuzeydoğu duvarı: 7269,85 ton (71292,86 kN) 

 Güneybatı duvarı: 7162,88 ton (70243,87 kN) 

 Kuzeybatı duvarı: 8538,2 ton (83731,12 kN) 

 Güneydoğu duvarı: 8180,53 ton (80223,64 kN) 

 Duvarların üstünde kalan kısım (kubbeler hariç): 14460,24 ton (141806,53 kN) 

 Ana Kubbe: 1849,26 ton (18135,01 kN) 
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 Toplam yarım kubbeler: 1540,27 ton (15104,91 kN) 

 Toplam ana yapıdaki diğer kubbeler: 2208,13 ton (21654,34 kN) 

 Toplam modelin iç kısmı: 13701,48 ton (134365,65 kN) 

 Toplam minarelerin ağırlığı: 4284,86 ton (42020,08 kN) 

 Toplam avlu duvarları: 10700,67 ton (104937,76 kN) 

 Toplam avlu kubbeleri: 1749,1 ton (17152,82 kN) olarak hesaplanmıştır. 

Yapının ağır olması nedeni ile en büyük basınç Düzce, Kobe ve Northridge 

depremlerindeki gibi Kocaeli depreminde de düşey eksende (S33) oluşmuştur. Yine 

basınç gerilmelerinin önemli bir kısmı yapının kendi ağırlığı nedeni ile oluşmuştur. 

Yapının tamamında basınç gerilmeleri çekme gerilmelerinden fazla çıkmıştır. 

Kubbelerde en fazla çekme gerilmesi Şekil 4.53 ve Şekil 4.55’de görüldüğü gibi yapı ile 

veya başka bir kubbe ile bağlandığı yerlerde oluşmuştur. Şekil 4.55’te Kocaeli depreminin 

(Y) bileşeni etkisi altındaki kubbelerin çekme gerilemelerinin üstten görünümü 

verilmiştir. Kubbelerde en fazla gerilme yeşil-mavi arası bölgelerde oluşmuştur. Yapıya 

kıyasla kubbelerde oluşan basınç ve çekme gerilmelerinin çok daha düşük seviyelerde 

kaldığı söylenebilir. 

Kayma emniyet gerilmesi için τem = τo+μσ denkleminden düşey gerilmeler sınır değeri 0,8 

MPa olarak ve çatlama emniyet gerilmesi 0,15 MPa olarak alınırsa τem = 0,15+0,5*0,8 = 

0,55 MPa olarak hesaplanır [51]. Bu durumda deprem anında yapıda oluşan maksimum 

kayma gerilmesi değerleri, kayma emniyet gerilmesi (τem) değerlerini aşmaktadır. 

Depremin X bileşeni için S12 yönündeki kayma emniyet gerilmesini aşan eleman sayısı 

23500 adet katı eleman içerisinde 35 adet katı eleman, 2658 adet kabuk eleman 

içerisinde 20 adet kabuk elemandır. S13 yönünde 326 katı eleman, S23 yönünde 163 katı 

elemandır. Depremin Y bileşeni için S12 yönünde 32 adet katı eleman, 18 adet kabuk 

eleman, S13 yönünde 159 adet katı eleman, S23 yönünde 255 adet katı elemandır. Tüm 

yapıya kıyasla emniyet değerini aşan eleman sayısı oldukça azdır. Kayma gerilmelerinin 

0,30 MPa’dan fazla olduğu bölgeler genel olarak katı elemanlarda kubbelerin altında, 

Kabuk elemanlarda ise ana kubbe ve yarım kubbelerin alt kısımlarındadır. 
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Şekil 4.48 Kocaeli depremi X bileşeninin yapıda oluşturduğu en büyük çekme 
gerilmeleri (Çizelge 4.11, S33) 

 

Şekil 4.49 Kocaeli depremi Y bileşeninin yapıda oluşturduğu en büyük çekme 
gerilmeleri (Çizelge 4.11, S33) 
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Şekil 4.50 Kocaeli depremi X bileşeninin yapıda oluşturduğu en büyük basınç 
gerilmeleri (Çizelge 4.12, S33) 

 

Şekil 4.51 Kocaeli depreminin Y bileşeninin yapıda oluşturduğu en büyük basınç 
gerilmeleri (Çizelge 4.12, S33) 
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Şekil 4.52 Kocaeli depremi Y bileşeninin etkisi altında yapıda oluşan düşey yöndeki 
çekme gerilmeleri (Çizelge 4.11, S33) 
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Şekil 4.53 Kocaeli depremi Y bileşeninin kubbelerde oluşturduğu en büyük çekme 
gerilmeleri (Çizelge 4.13, S11) 

Çizelge 4.10’daki yapının yer değiştirme miktarlarına bakıldığında büyük kubbenin çok 

düşük miktarlarda yer değiştirme yaptığı görülmektedir. Ana taşıyıcı sistem rijit 

davranarak düşük miktarda yer değiştirme göstermiştir. Yapının en fazla yer değiştirme 

gösteren yerleri x yönünde etki ettirilen deprem için 2 nolu doğu minaresinin tepe 

noktası, y yönünde etki ettirilen depremin pozitif yönünde 1 nolu güney minaresi negatif 

yönünde ise 4 nolu batı minaresidir. Ayrıca batı minaresi 111,8 mm ile her iki yöndeki 

Kocaeli depremi etkisi altındaki en büyük yer değiştirmeyi de göstermiştir. Y yönünde 

etti ettirilen depremde bütün minarelerin tepe noktaları birbirlerine yakın miktarlarda 

yer değiştirme göstermiştir. Şekil 4.54’de yer değiştirme miktarları sayısal olarak 

belirlenen noktaların yapı üzerindeki yerleri gösterilmiştir. Çizelge 4.15’de ise her 10 
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saniyede bir bu noktaların yer değiştirme miktarları sayısal olarak gösterilmiştir. Yer 

değiştirme miktarları mm cinsinden olup deprem bileşeni yönündedir. 

 

Şekil 4.54 Yer değiştirme miktarları belirlenen noktaların yapı üzerinde gösterimi 
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Çizelge 4.15 Belirli zamanlarda yapıda oluşan yer değiştirme miktarları (sn-mm) 

Zaman 
Deprem 
Bileşeni 

Tepe 
Kubbe 

Tepe 
Güney (1) 

Tepe 
Doğu (2) 

Tepe 
Kuzey (3) 

Tepe 
Batı (4) 

10 
X 0,001 0,163 0,169 0,091 0,091 

Y 0 0,028 0,025 0,013 0,013 

20 
X 0,348 10,243 10,146 11,627 11,663 

Y -0,08 -7,872 -7,822 -8,414 -8,438 

30 
X -0,446 41,575 39,838 32,75 33,546 

Y -0,66 -33,542 -31,143 53,017 54,462 

40 
X 0,578 -1,795 -15,065 31,395 31,532 

Y 0,894 83,465 83,405 -17,623 -16,563 

50 
X -0,179 -19,097 -15,333 4,815 5,182 

Y -0,273 -32,09 -40,584 24,547 25,35 

60 
X -0,459 21,209 30,799 -21,741 -21,942 

Y -0,547 54,922 63,425 -44,248 -45,046 

70 
X -0,199 34,581 26,111 -34,924 -35,596 

Y 0,118 -12,845 -20,893 3,839 3,696 

80 
X -0,118 -32,181 -36,719 -3,081 -3,274 

Y 0,197 -12,419 -7,417 14,709 14,903 

90 
X -0,055 -12,03 -5,524 -1,372 -1,679 

Y 0,131 9,448 8,84 -5,855 -6,273 

100 
X -0,047 12,407 13,873 2,578 2,507 

Y -0,043 -9,379 -10,962 8,893 8,843 
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Çizelge 4.15 Belirli zamanlarda yapıda oluşan yer değiştirme miktarları 
(sn-mm) (devamı) 

Zaman Deprem Bileşeni 1 2 3 4 5 6 

10 
X 0,001 0,001 0,001 0,001 0,001 0,001 

Y 0 0 0 0 0 0 

20 
X 0,186 0,226 0,224 0,172 0,161 0,159 

Y -0,018 -0,015 -0,015 -0,016 -0,012 -0,02 

30 
X -0,348 -0,436 -0,426 -0,302 -0,296 -0,292 

Y -0,116 -0,144 -0,139 -0,107 -0,497 -0,302 

40 
X 0,395 0,497 0,483 0,369 0,358 0,351 

Y 0,092 0,119 0,116 0,086 0,438 0,404 

50 
X -0,156 -0,198 -0,194 -0,146 -0,154 -0,156 

Y 0,015 0,008 0,006 0,015 -0,047 -0,07 

60 
X -0,093 -0,224 -0,212 -0,086 -0,125 -0,101 

Y -0,038 -0,057 -0,056 -0,035 -0,243 -0,225 

70 
X -0,115 -0,143 -0,142 -0,11 -0,102 -0,096 

Y 0,022 0,028 0,027 0,022 0,094 0,07 

80 
X -0,035 -0,068 -0,066 -0,032 -0,049 -0,048 

Y 0,023 0,028 0,028 0,02 0,097 0,087 

90 
X -0,011 -0,028 -0,025 -0,006 -0,015 -0,014 

Y 0,015 0,02 0,019 0,014 0,068 0,059 

100 
X -0,028 -0,035 -0,034 -0,026 -0,022 -0,019 

Y -0,001 -0,003 -0,003 -0,002 -0,016 -0,015 

 

Zaman Deprem Bileşeni 7 8 9 10 11 12 

10 
X 0,001 0,001 0,001 0,001 0,001 0,001 

Y 0 0 0 0 0 0 

20 
X 0,158 0,209 0,21 0,143 0,15 0,159 

Y -0,045 -0,029 -0,027 -0,044 -0,02 -0,012 

30 
X -0,032 -0,366 -0,373 -0,04 -0,289 -0,303 

Y -0,127 -0,078 -0,086 -0,124 -0,307 -0,494 

40 
X 0,169 0,458 0,462 0,203 0,347 0,363 

Y 0,303 0,123 0,134 0,285 0,408 0,432 

50 
X -0,158 -0,19 -0,188 -0,151 -0,156 -0,156 

Y -0,084 -0,006 -0,006 -0,053 -0,068 -0,041 

60 
X 0,058 -0,158 -0,171 0,026 -0,068 -0,105 

Y 0,121 0,002 -0,017 0,082 -0,223 -0,233 

70 
X 0,022 -0,13 -0,128 0,046 -0,081 -0,096 

Y -0,034 0,006 0,013 -0,014 0,068 0,093 

80 
X -0,129 -0,056 -0,057 -0,102 -0,042 -0,042 

Y 0,008 0,018 0,021 -0,002 0,084 0,098 

90 
X -0,024 -0,014 -0,017 -0,042 -0,018 -0,017 

Y 0,036 0,015 0,017 0,033 0,057 0,069 

100 
X 0,035 -0,03 -0,03 0,025 -0,016 -0,022 

Y -0,029 -0,005 -0,004 -0,022 -0,015 -0,017 
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Şekil 4.55 Kocaeli depremi Y bileşeninin kubbelerde oluşturduğu en büyük çekme 
gerilmelerinin üstten görünümü (Çizelge 4.13, S11) 
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BÖLÜM 5 

SONUÇ VE ÖNERİLER 

Çalışma kapsamında Süleymaniye Camii, Sap2000 uygulamasında sonlu elemanlar 

yöntemi ile makro modelleme tekniğine göre 3 boyutlu olarak modellenmiştir. Kubbeler 

kabuk eleman olarak modellenirken yapının geri kalanı katı eleman olarak 

modellenmiştir. Uzun uğraşlar neticesinde yapının gerçek serbest titreşim frekansına 

oldukça yakın frekansa sahip bir şekilde yapının gerçekçi bir modeli oluşturulmuştur. Bu 

çalışmadaki elde edilen frekanslar ile geçmiş çalışmalarda elde edilen frekansların 

karşılaştırılması yapılmış ve geçmiş çalışmalar ile uyumlu olduğu görülmüştür. 

Modelleme aşamasından edinilen tecrübeye dayalı olarak karmaşık yapıların 

modellemesi hakkında bilgiler verilmiş, modelleme tekniklerinden bahsedilmiş ve 

yapının nasıl modellendiği anlatılmıştır. Yapının tarihi, konumu, mimari özellikleri ve 

yakın geçmişteki kubbe restorasyonu hakkında bilgiler verilmiştir. 

Yapının iki farklı şekilde analizi yapılmıştır. İlkinde üç adet farklı karakteristik özelliğe 

sahip tarihi büyük deprem yapıya etti ettirilmiştir. İkincisinde ise yapının Kocaeli 

depreminin zemin etkisi dikkate alınarak analizi yapılmıştır. Bölgede 2,25 km2’lik bir alan 

seçilerek bu alan içerisindeki zemin etüt verileri analiz edilmiş ve 3 boyutlu zemin modeli 

oluşturulmuştur. Üretilen zemin modeli incelendiğinde yapının yaklaşık olarak ana kaya 

üzerinde olduğu ortaya çıkmıştır. Bu nedenle bütün deprem analizlerinde yapının 

zemine temas eden bütün noktaları tamamen rijit (Ux, Uy, Uz, Rx, Ry, Rz) seçilmiştir. 

Uygulama amacı ile 1999 Kocaeli depremi sırasında Zeytinburnu istasyonunda alınan 

ivme kayıtları Ters Fourier dönüşümü ile ana kayaya indirgenmiş, buradan da zemin 

modeli üzerinde büyütme analizleri yapılarak yüzeye taşınmıştır. Elde edilen kuvvetli yer 
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hareketleri etkisi altında yapı analiz edilmiştir. Bütün bu deprem analizleri neticesinde 

aşağıdaki sonuçlara varılmıştır. 

 Ana yapı deprem etkileri karşısında rijit davranmıştır. Çok düşük miktarlarda yer 

değiştirme hareketi yaparken düşük miktarlarda da çekme gerilmesi oluşmuştur. 

Ana yapı üzerinde en fazla çekme gerilmesinin oluştuğu yerler pencere boşlukları 

gibi boşlukların çevresinde olmuştur. Pencerelerin çoğu yapının X ekseni 

doğrultusunda yer almaktadır. Aynı şekilde X ekseni doğrultusunda gelen 

depremlerde pencere çevresindeki çekme gerilmeleri, Y ekseni doğrultusunda 

gelen depreme göre daha fazla çıkmıştır. 

 Kubbeler yapının geri kalanına oranla çok daha az gerilmelere maruz kalmıştır. 

En fazla gerilmeler kubbelerin yapı ile birleştiği bölgelerde ve kubbelerin birbiri 

ile birleştiği bölgelerde oluşmuştur. Ana kubbe en fazla yer değiştirme miktarını 

13,83 mm ile Kobe Depreminde (x) gerçekleştirirken, Northridge (x) 9,64 mm, 

Kocaeli (x) 3,41 mm ve Düzce (x) 1,97 mm şeklinde depremlerin maksimum yer 

değiştirmeleri sıralanabilir.  

 Minareler ise yapının tamamına bakıldığında en fazla çekme gerilmelerin 

oluştuğu yerlerdir. Bu çekme gerilmeleri minarelerin alt kısımlarında meydana 

gelmektedirler. Minarelerin yapının geri kalanı kadar rijit oldukları söylenemez. 

Yapıdaki en fazla yer değiştirme gösteren yerler de beklenildiği gibi minare 

tepeleridir. En büyük yer değiştirme Kobe Depreminde (x) 251,6 mm ile uzun olan 

minarelerden 1 nolu güney minaresinde oluşmuştur. Kocaeli depreminde (y) kısa 

olan minarelerden 4 nolu batı minaresinde 111,8 mm, Northridge depreminde 

(y) uzun olan minarelerden 1 nolu güney minaresinde 106,9 mm, Düzce 

depreminde (y) uzun olan minarelerden 2 nolu doğu minaresinde 23 mm 

depremlerin maksimum yer değiştirme miktarları olmuştur. 

 Yapı, basınç gerilmeleri bakımından incelendiğinde ise en fazla basınç 

gerilmesinin S33 (Z ekseni) yönünde oluştuğu görülmektedir. Deprem etkisi 

altında olmadan yapının kendi ağırlığı nedeni ile oluşan maksimum basınç 

gerilmesi 2,35 MPa’dır. Basınç gerilmesi genel olarak yukardan aşağı doğru artsa 
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da ana kubbenin kasnaklarında da önemli miktarda basınç oluşmaktadır. Hem 

ana kubbe hem de yapının geneli oldukça ağırdır. 

Süleymaniye Camii’nin statik analiz sonuçları incelendiğinde düşey yükler altında 

herhangi bir risk teşkil edecek duruma rastlanmamış ve yapının düşey yükleri güvenli 

olarak taşıdığı sonucuna varılmıştır. Dinamik analiz sonucunda ise, genel olarak yapının 

depremlere karşı çok iyi bir performans sergilediği görülmektedir. Buna rağmen ivme 

kaydının alındığı istasyondan 19 km uzaklıkta gerçekleşmiş Kobe depremi gibi büyük bir 

depremin yapının yakınlarında gerçekleşmesi durumunda pencere boşluklarının çevresi 

özellikle fil ayakları arasındaki ana kemerlerin altındaki pencere boşlukları olmak üzere 

yapı ciddi çekme gerilmelerine maruz kalabilir. Bu gibi durumda bu bölgelerde çok sayıda 

çatlak hatta hasar beklenebilir. Bunun dışında minareler yapıdan daha narindirler. 

Depremlerde oluşacak çatlak ve hasarlar öncelikle ve en fazla minarelerde 

beklenmektedir. Yapının yakınlarında oluşacak ciddi bir deprem minarelere ciddi zararlar 

verebilir. Bu nedenle minarelere çekme gerilmelerini karşılayacak takviyeler yapılması 

önerilmektedir. Bunun dışında yapıda bazı çatlaklar oluşabilir ama yapının yıkılma riski 

olmadığı görülmektedir. 
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